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Zusammenfassung  

Das vorliegende Projekt ist Teil des Forschungsprogramms Wasserkraft. Es hat zum Ziel, 
das Kleinwasserkraftpotenzial (≤10MW) der Schweiz basierend auf einem holistischen 
Ansatz zu ermitteln. Im Zentrum steht die Entwicklung einer ganzheitlichen 
Erfassungsmethodik, die sowohl die drei Dimensionen Umwelt, Wirtschaft und Gesellschaft 
als auch Aspekte der regionalen Raumplanung gleichwertig integriert. Im vergangenen Jahr 
wurde vor allem am Konzept der Methodik Version 1 und deren Überprüfung in Testregionen 
gearbeitet. Mit der Unterstützung zweier Masterstudenten konnten erstmals Ergebnisse für 
die Pilotregion Lütschine vorgelegt werden. Trotz Erfolg zeigten diese Resultate auch diverse 
Schwierigkeiten. Die Methodik Version 1 verlangte nach einer Überarbeitung. Zusätzliche 
Ergebnisse einer Anwendung in einer Pilotregion 2 wie auch Rückmeldungen aus der 
wissenschaftlichen Begleitgruppe lieferten weitere Anhaltspunkte, so dass zurzeit eine 
Methodik Version 2 ausgearbeitet wird. Das Projekt konnte im Verlaufe des Jahres an 
verschiedenen Veranstaltungen mit unterschiedlichem Publikum präsentiert werden. 
Insgesamt sind die Ziele für 2010 erreicht worden, wenn auch mit gewisser Verzögerung. 
Das Projekt bewegt sich nach wie vor in die richtige Richtung und ist realistisch, die Ziele für 
2011 planmässig zu erfüllen. 

 

 

 

 

 

 

 

 

Projektziele 

Das Projekt befasst sich mit dem Kleinwasserkraftpotenzial (≤10MW) in der Schweiz und 
bewegt sich somit im Spannungsfeld rund um die Wasserkraftnutzung. Der Ausbau der 
erneuerbaren Energien, wie es die aktuelle Energiepolitik des Bundes vorsieht, führt 
unweigerlich zu einer Intensivierung dieses Spannungsfeldes von Nutzungs- und 
Schutzansprüchen an die Ressource Wasser. Die Abwägungen zur Nutzbarmachung des 
verbleibenden Potenzials sind schwierig und die dazu vorliegenden Hilfsmittel bisher von 
unzureichender Beurteilungstiefe. Diese vernachlässigen insbesondere die ganzheitliche 
Betrachtungsweise sowie den regionalen und raumplanerischen Kontext. 

Das vorliegende Projekt hat sich deshalb zum Ziel gesetzt, die notwendigen Leitlinien und 
Empfehlungen in Form eines Beurteilungsinstrumentes bereitzustellen. Dazu sollen 
technische Daten über das hydroelektrische Potenzial mit ökologischen, gesellschaftlichen 
und ökonomischen Beurteilungen verbunden werden, um letztlich zu einer ganzheitlichen 
Beurteilung des Wasserkraftpotenzials einer Region zu gelangen. Da eine möglichst breite 
Abstützung der Methodik wichtig ist, soll sie in Zusammenarbeit mit verschiedenen 
Interessensvertretern entstehen. Die Entscheidungshilfe richtet sich schliesslich an die 
kantonalen Fachstellen und Behörden und dient der Planung zukünftiger 
Wassernutzungsstrategien. Folglich wird eine Darstellung der Ergebnisse sowohl im 
regionalen als auch nationalen Kontext angestrebt.  

Insgesamt setzt sich das Projekt aus den drei Teilprojekten A, B und C zusammen, wobei 
Teilprojekt B am Geographischen Institut der Universität Bern (GIUB) bearbeitet wird und 
Gegenstand dieses Berichtes ist. 
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Ziele für das Berichtsjahr 2010 

Gemäss Jahresbericht 2009 sind folgende Ziele für das Berichtsjahr 2010 vorgesehen. Diese 
Zielsetzungen beziehen sich auf den Arbeitsablauf in Abbildung 1. 

 

 
Abbildung 1 Ablauf des Vorgehens Methodik Version 1 

 
1. Methodik 

1.1. Konzept 

Die Methodik soll in eine anwendbare Form gebracht werden, d.h., sowohl die 
Bewertungskriterien als auch das Vorgehen zur Berechnung der Systemleistung sollen fertig 
gestellt werden (Schritt 1, Abbildung 1). Damit verbunden sind Arbeiten wie bspw. die 
Aktualisierung der Datenbeschaffung, die Ausarbeitung der Schritte 2 und 3 (Abbildung 1) 
und daraus folgend die allfällige Überarbeitung und Anpassung der Methodik Version 1. 

Ergebnis: Methodik Version 1 

Zweck: Grundlage für Anwendungen in Pilotregion 1 & 2 

 

1.2. Anwendung 

Die Methodik Version 1 soll in Pilotregion 1 (Lütschine) angewendet und überprüft werden, 
d.h., es erfolgt zunächst eine Bewertung des Ist-Zustandes auf der Ebene der 
Gewässerräume und der Landschaftsteilräume. Danach folgt die Synthese zur Berechnung 
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der Systemleistung im Einzugsgebiet. Des Weiteren soll eine Pilotregion 2 definiert werden, 
in der die Methodik Version 1 ebenfalls angewendet wird. Es soll überprüft werden, ob sie 
auch in einer anderen Region der Schweiz wunschgemäss funktioniert. 

Ergebnis: Probleme der Methodik Version 1 identifizieren 

Zweck: Grundlage zur Ableitung von Anpassung bzw. Änderungen der Methodik Version 1 

 

1.3. Anpassungen / Änderungen 

Ausgehend von den Ergebnissen der Anwendungen der Methodik Version 1 sollen 
entsprechende Anpassungen und Änderungen vorgenommen werden 

Ergebnis: Vorschlag Methodik Version 2 

Zweck: Grundlage für Anwendung in weiteren Testgebieten und Szenarienbildung 

 
2. Wissenschaftliche Begleitgruppe 

Die Begleitgruppe des Projekts soll weiterhin über den Stand der Arbeiten und das Vorgehen 
informiert werden. Zweimal jährlich sollen die Teilnehmer/innen die Möglichkeit haben, 
kritische Rückmeldungen und Ratschläge abgeben zu können. Somit übernimmt die 
Begleitgruppe wie bisher eine Kontroll- und Steuerungsfunktion und soll die Verbindung 
zwischen Wissenschaft und Praxis garantieren. 

 
3. Masterarbeiten 

Die beiden Masterarbeiten Baumgartner und Studer, welche sich mit der Bewertung von 
Gewässerräumen und Landschaftsteilräumen auseinandersetzen (Schritt 1, Abbildung 1) 
sollen im Sommer 2010 abgeschlossen werden. Damit wird eine Bewertung für Pilotregion 1 
(Lütschine) vorliegen. Ebenso wird eine Auswertung der Methodik Version 1 erwartet. 

Zur Unterstützung des Projektes wird eine weitere Masterarbeit ausgeschrieben. Sie soll 
dazu dienen, die Methodik Version 1 in einer Pilotregion 2 zu testen (vgl. 1.2). Es werden 
Vorschläge zur Anpassung der Methodik Version 1 erwartet, gegebenenfalls gefolgt von 
einer Methodik Version 2, die in weiteren Testgebieten überprüft werden soll. 

 
4. Verknüpfung zu Teilprojekt A Water GIS Web AG 

Die Schnittstelle zu Teilprojekt A Water GIS Web AG soll konkretisiert und unter beidseitigem 
Einverständnis definiert werden. 

 
5. Veranstaltungen mit aktiver Teilnahme  

Für folgende Veranstaltungen ist eine aktive Teilnahme (Referat, Paper, Poster) vorgesehen: 

– UNESCO Chair International Conference on Technologies for Development, Lausanne 
(08.-10. Februar 2010) 

– Tag der Hydrologie, Braunschweig (25.-26. März 2010) 

– Dritte bzw. vierte Sitzung der wissenschaftlichen Begleitgruppe (06. Mai / 17. Nov. 2010) 

Zudem soll ein erstes Paper verfasst werden. 
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Durchgeführte Arbeiten und erreichte Ergebnisse 

Die folgende Auflistung der durchgeführten Arbeiten und erzielten Resultate bezieht sich auf 
das Kapitel Ziele für das Berichtsjahr 2010 des vorliegenden Berichtes.  

 
1. Methodik 

Abbildung 2 gibt einen Überblick über die methodischen Arbeitsschritte und deren 
Verknüpfungen im Verlaufe des Jahres 2010. 

Anwendung Testregion 1

Aggregation

2009 2010 2011

Testregion 2

Grundlagen, Daten                    

Methodik 1 (Abgrenz., Bewert.-Krit.)

Organisation, Konzept

Schlussbericht

Methodik 2 (angepasst)

Szenarienbild.

Integration WK-Pot.

Anwendung Testregion 1

Aggregation

Testregion 2

Grundlagen, Daten

Methodik 1 (Abgrenz., Bewert.-Krit.)

Organisation, Konzept

Schlussbericht

Methodik 2 (angepasst)

Szenarienbild.

Integration WK-Pot.

Anwendung Testregion 1

Aggregation

Testregion 2

Grundlagen, Daten

Methodik 1 (Abgrenz., Bewert.-Krit.)

Organisation, Konzept

Schlussbericht

Methodik 2 (angepasst)

Szenarienbild.

Integration WK-Pot.

 
Abbildung 2 Zeitplan 2009 bis 2011. Schwerpunkte der Tätigkeiten im Berichtsjahr 2010 bildeten 
die Erarbeitung der Methodik Version 1, deren Anwendung in zwei Testregionen und die daraus resul-
tierende Methodik Version 2. 
 

Nachfolgend wird auf die drei Schwerpunkte des Berichtsjahres eingegangen (Abbildung 2). 

1.1. Methodik Version 1 

Die Disposition des Teilprojektes B wurde im April 2010 überarbeitet und best möglich dem 
aktuellsten Vorgehen angepasst (Abbildung 1 und Anhang 1). Die Datenbeschaffung wurde 
fortgesetzt und aktualisiert. In Zusammenarbeit mit den Masterstudenten Baumgartner und 
Studer wurden die Kriterienlisten zur Bewertung der Gewässerräume und der 
Landschaftsteilräume fertig gestellt (Anhang 2).  

1.2. Anwendungen Pilotregion 1 & 2 

Die Anwendung der Methodik Version 1 in der Pilotregion 1 (Lütschine) führte zu einer 
ganzheitlichen Bewertung der Gewässerräume bzw. Landschaftsteilräume; d.h., aus den 
Masterarbeiten Baumgartner und Studer resultierten jeweils drei verschiedene Karten 
entsprechend der ökologischen, sozio-kulturellen und wirtschaftlichen Sichtweise (Abbildung 
3). Daraus liessen sich die in der Pilotregion dominierenden Dimensionen ableiten, was die 
spätere Entscheidung zwischen Nutzung und Schutz erleichtern soll. 
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Abbildung 3 Ganzheitliche Beurteilung der Gewässerräume (links) und der Landschaftsteilräume 
(rechts) der Pilotregion Lütschine (aus Baumgartner 2010: 63, 77, 89 und Studer 2010: 98-100). 
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Abbildung 4 Systemleistung der Pilotregion Lütschine (links) und Gegenüberstellung des Wasser-
kraftpotenzials und der Systemleistung (rechts). Die Punkte zeigen die Systemleistung pro Gewässer-
raum aufgeteilt in die drei Dimensionen. 
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Zudem konnte aufgrund der Ergebnisse die Systemleistung für die Pilotregion 1 bestimmt 
werden (Abbildung 4, rechts). Dazu wurde die in der Projekt-Disposition vorgeschlagene 
Formel verwendet: 

 
LTR: Landschaftsteilraum   
GR: Gewässerraum 
U: Umwelt 
G: Gesellschaft 
W: Wirtschaft 
a: Gewichtungsfaktor LTR 
b: Gewichtungsfaktor GR 
 

Entsprechend wurden die Bewertungen der Gewässerräume und die Bewertungen der 
Landschaftsteilräume mit spezifischen Gewichtungsfaktoren multipliziert und anschliessend 
summiert. Somit kann erstmals eine ganzheitliche Beurteilung einer Region vorgelegt 
werden. 

Gemäss Schritt 2 des Arbeitsablaufs in Abbildung 1 sollte daraufhin die Gegenüberstellung 
von Wasserkraftpotenzial und Systemleistung erfolgen. Abbildung 4 (links) zeigt eine erste 
Auswertung für jeden einzelnen Gewässerraum (Abbildung 4, links). 

Des Weiteren wird gemäss Schritt 3 in Abbildung 1 für die Schutz- und Nutzungszuweisung 
pro Gewässerraum die graphische Darstellung des Ternary Plots vorgeschlagen. Dabei 
würde jedem Gewässerraum, analog des Verhältnisses der drei Dimensionen, ein Punkt im 
Dreieck zugeordnet (Abbildung 5). Die in Abbildung 5 eingefügten Linien zeigen eine 
Möglichkeit, wie die Zuweisung von Schutz, Nutzung oder Abwägung pro Gewässerraum 
vorgenommen werden könnte. Allerdings wurden diese Arbeitsschritte aufgrund der in 
Tabelle 1 aufgeführten Probleme nicht abschliessend durchgeführt. 

 
Abbildung 5 Ternary Plot zur Darstellung der Systemleistung der Gewässerräume im Lauterbrun-
nental (Pilotregion Lütschine). Jeder Gewässerraum wird analog seiner Anteile der drei Dimensionen 
im Dreieck als Punkt lokalisiert. 

Die Auswahl der Emme als Pilotregion 2 sollte zeigen, ob die Methodik Version 1 auch in 
einer mittelländischen Region anwendbar ist. Bereits bei der Abgrenzung zeigten sich erste 
Probleme, welche durch weitere Unstimmigkeiten bei der Bewertung ergänzt wurden. 
Letztlich resultierte eine Liste aller Schwachstellen der Methodik Version 1, die es zu 
korrigieren galt (Tabelle 1). 
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1.3. Anpassungen / Änderungen 

Unter Beibehaltung der Vorteile der Methodik Version 1 wurden die in Tabelle 1 aufgeführten 
Anpassungen durchgeführt bzw. werden zurzeit vorgenommen. 

Tabelle 1 Vorteile und Schwierigkeiten der Methodik Version 1 (Stand 17.11.2010) 

 
 

In Anlehnung an Abbildung 1 ist in Abbildung 6 ein erster konzeptioneller Entwurf einer 
überarbeiteten, zweiten Version der Methodik dargestellt. Es ist zu beachten, dass diese 
Methodik Version 2 Gegenstand aktueller Untersuchungen ist. 

 

 
Abbildung 6 Methodik Version 2 
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2. Wissenschaftliche Begleitgruppe 

In Verlaufe des Berichtsjahres 2010 traf sich die Begleitgruppe zweimal zu einer Sitzung, am 
06. Mai 2010 und am 17. November 2010. Im Frühjahr wurden die Kriterienkataloge der 
Methodik Version 1 abgesegnet und das Vorgehen allgemein gut geheissen. Bei der letzten 
Sitzung wurde auf die Probleme bei der Anwendung der Methodik Version 1 hingewiesen 
und eine Version 2 der Methodik vorgeschlagen. Die Teilnehmer reagierten insgesamt 
positiv auf den Vorschlag, wobei einige kleinere Änderungen ins weitere Vorgehen 
aufzunehmen sind (Anhang 3). 

 
3. Masterarbeiten 

Mit der Abgabe einer schriftlichen Arbeit und einem Referat konnten die beiden 
Masterstudenten Baumgartner und Studer ihr Studium in Geographie im verlaufe des 
Sommers 2010 erfolgreich abschliessen. 

Anfang Juli 2010 begann eine weiteren Masterarbeit. J. Hirschi widmet sich insbesondere 
der Anwendung der Methodik Version 1 in Pilotregion 2 (Emme) und der daraus folgenden 
Anpassungen der Methodik (vgl. 1.2). Erste Ergebnisse aus Hirschi flossen in die 
Zusammenstellung der Schwierigkeiten in Tabelle 1 ein. Zurzeit findet ein 
aktiver/dynamischer Austausch zwischen Masterarbeit und Dissertation statt. 

 
4. Verknüpfung zu Teilprojekt A Water GIS Web AG 

Am 18. Februar 2010 fand ein Treffen mit U. Schröder statt. Dabei wurden einige 
Unklarheiten bezüglich der vom Teilprojekt A n der WaterGIS Web AG zur Verfügung 
gestellten Daten des theoretischen Wasserkraftpotenzials geklärt. Insbesondere wurden 
aber die Schnittstellen der beiden Teilprojekte A und B besprochen, d.h., das GIUB 
präsentierte einen Vorschlag für den Datenaustausch, dem U. Schröder zustimmte. 
Zentrales Dokument war das Datenmodell GIUB (Anhang 4). 

Wie die weitere Zusammenarbeit der Teilprojekte A und B aussieht, ist noch nicht festgelegt. 

 
5. Veranstaltungen, Referate, Publikationen 

Tabelle 2 Besuchte Veranstaltungen mit aktiver Teilnahme 

2010 Veranstaltung Beitrag 

08.-10.02. UNESCO Chair International Conference on Technologies for 
Development, Lausanne 

Referat & 
Paper 

25.-26. 
03. 

Tag der Hydrologie 2010: Nachhaltige Wasserwirtschaft durch Integration 
von Hydrologie, Hydraulik, Gewässerschutz und Ökonomie, 
Braunschweig 

Poster 

30.04. Arbeitsbesprechung Physische Geographie GIUB, Schwarzenburg Referat 

04.-05.05. Berner Umweltforschungstag 2010, Bern Poster 

16.-18.06. Hidroenergia 2010, Lausanne Referat & 
Paper 

19.-20.11. 8th Swiss Geoscience Meeting, Fribourg Referat 
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Tabelle 3 Organisierte Veranstaltungen 

2010 Veranstaltung Beitrag 

06.05. Sitzung III Wissenschaftliche Begleitgruppe Referat 

21.06. Blockkurs Hydrologie FS2010: Exkursion ‚Hochwasserabschätzungen in 
Wildbacheinzugsgebieten’, St. Stefan 

Referat 

17.11. Sitzung IV Wissenschaftliche Begleitgruppe, Bern Referat 

 

Tabelle 4 Weitere besuchte Veranstaltungen 

2010 Veranstaltung 

31.05. Projektleiter-Treffen, Bern 

03.06. Masterreferat D. Studer, Bern 

14.06. Info-Veranstaltung Wasseragenda 21: Schutz und Nutzung der Gewässer - 
Umsetzung des Parlamentsbeschlusses, Solothurn 

30.08. Jahrestagung NWB, Lugano 

09.10. Besichtigung Kleinwasserkraftwerk Taubenloch, Biel 

14.10. Masterreferat I. Baumgartner, Bern 

25.11. Informationstagung der EAWAG zum Projektes ‚Integriertes 
Flussgebietsmanagement’: Flussrevitalisierungen - Synergien zwischen 
Hochwasserschutz und Ökologie, Bern 
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Bewertung 2010 

Die Ziele des Berichtsjahres 2010 und ihr Erfüllungsgrad sind in Tabelle 4 aufgeführt. Daraus 
leitet sich die Bewertung in Tabelle 5 ab. 

Tabelle 5 Erfüllungsgrad der Ziele 2010 

Ziele 2010 Erfüllungsgrad 

1. Methodik (Version 1) 

  1.1 Konzept 

  1.2 Anwendung 

  1.3 Anpassungen / Änderungen 

erreicht 

Zu beachten: Die Arbeiten bezüglich der Anpassungen 
der Methodik Version 1 konnten noch nicht 
abgeschlossen werden 

2. Wissenschaftliche Begleitgruppe erfolgreich 

3. Masterarbeiten erfolgreich abgeschlossen (zwei) und eine neu initiiert 

4. Verknüpfung zu Teilprojekt A Water 

GIS Web AG 
erreicht, soweit zu gegebenem Zeitpunkt möglich 

5. Veranstaltungen mit aktiver Teilnahme erfolgreich 

 

Tabelle 6 SWOT-Analyse des Berichtsjahres 2010 

Strength Options 

– Kriteriensammlung basierend auf 
Nachhaltigkeitsprinzip vorhanden 

– Bewertung für ein Einzugsgebiet 
abgeschlossen (Methodik Version 1) 

– Projektarbeiten durch mehrere 
Masterarbeiten unterstützt 

– Meilensteine weitgehend erreicht (Tabelle 
5) 

– Projekt an wissenschaftlichen Tagungen 
präsentiert 

– Ansatz garantiert nach wie vor den 
Einbezug der Detailebene als auch einer 
grossräumigen Perspektive 

– Dialog mit Begleitgruppe 

– Flexibilität des Vorgehens (Lernprozess aus 
Methodik Version 1 führte zur Entwicklung der 
Methodik Version 2) 

– Methodik Version 2 erscheint 
erfolgsversprechend zu sein 

– Lerneffekt aus ähnlichen Studien (z.B. AWA 
2010), z.T. unter Beteilung des GIUB 

Weaknesses Threads 

– subjektive Komponente nicht ganz 
auszuräumen 

– noch zu grosser Parametersatz und zu 
grosser Zeitaufwand bei der 
Parametererhebung 

– Abgrenzung zwischen wissenschaftlicher 
Beurteilung und politischer 
Entscheidungsfindung noch nicht sauber 
definiert 

– Komplexität der Materie 

– Abgrenzung zu abgeschlossenen oder 
laufenden Studien 
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Ausblick 2011 

Aus der vorangehenden Bewertung des Berichtsjahres 2010 ergeben sich folgende 
Arbeitsschritte für das Jahr 2011 (Tabelle 6). 

Tabelle 7 Zeitplanung 2011 

Ziele 2011 zu erledigen bis … 

1. Methodik (Version 2) 

  1.1 Konzept (theor.) & Vorgehensablauf (techn.) 

  1.2 Anwendung in vers. Test-Strecken bzw. -Regionen 

  1.3 Auswertung, Aggregation, Nutzungsszenarien 

 

Ende April 

Juni/August 

Ende September 

2. unterstützende Kurse (GIS, R, etc.) Juni/Juli 

3. Kochbuch Methodik bzw. Tool für Zielgruppe Oktober 

4. Wissenschaftliche Begleitgruppe 18. Mai 

5. Masterarbeit (J. Hirschi) November 

6. Verknüpfung zu Teilprojekt A Water GIS Web AG Ende April 

7. Veranstaltungen mit aktiver Teilnahme offen 

8. Paper I bzw. II März bzw. Juli 

9. Abgabe Diss (zu klären im Februar 2011: Paper-Diss od. Monographie?) Anfang März 2012 

10. Referat Diss Ende Mai 2012 
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1 Zielsetzung 

1.1 Ziele des Gesamtprojektes 

Schlagwörter: 

Wasserkraft, Potentialanalyse, Geodaten, ganzheitliche Betrachtung, Raumplanung, 

Kleinwasserkraftwerke (KWKW) 

 

 

Übersicht über die Potentiale; Bereitstellen von Entscheidungsgrundlagen und Leitbild 

Teilprojekt C Netzwerk Wasser im Berggebiet NWB 

Teilprojekt B 
Dissertation GIUB 

Analyse 
des hydro-elektrischen Potentials 

sowie der Systemleistung des Raumes 

Gesamtheitliche Beurteilung 
des Wasserkraftpotentials 

Raumplanerische Aspekte 

Theoretisches und 
technisches 
Potential 

Teilprojekt A 
WaterGISWeb AG 

Region 

Einzugsgebiet 

Gewässer
abschnitt 

Begleitgruppe Teilprojekt B  

(Fokus Methodik, Leitung: GIUB) 

Begleitgruppe Gesamtprojekt (Fokus Umsetzung, Leitung: D. Soldo) 

 
Abbildung 1 Übersicht über das gesamte Projekt. 
 

Die Nutzung der Fliessgewässer für die Erzeugung elektrischer Energie steht im 

Spannungsfeld von Nutzungs- und Schutzansprüchen an die Ressource Wasser. Die 

übersichtsmässige Beurteilung des Wasserkraftpotentials, wie sie heutzutage von 

verschiedener Seite gewünscht und gefördert wird, vernachlässigte bisher die 

ganzheitliche Sicht sowie den regionalen und raumplanerischen Kontext. Ziel dieses 

Projekts ist es, technische Daten über das Potential für Kleinwasserkraftwerke mit 

sozio-ökonomischen und ökologischen Beurteilungen zu verbinden, um letztlich zu 

einer ganzheitlichen Beurteilung des Wasserkraftpotentials zu gelangen. Es soll ein 

Instrumentarium entwickelt und angewandt werden, mit dem sich das 

Wasserkraftpotential und die Systemleistung sowohl der Landschaft als auch des 

Gewässerraumes in den Einzugsgebieten einer Region beziffern und vergleichen 
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lassen. Letztlich soll dies zu einer differenzierten Sicht des Wasserkraftpotentials 

führen. 

Teilprojekt A 

Ermittlung des hydroelektrischen Potentials für Kleinwasserkraftwerke in der Schweiz 

der WaterGisWeb AG. Für alle Fliessgewässer der Schweiz sowie für die 

Einzugsgebiete und Regionen wird flächendeckend das theoretisch nutzbare und 

das bereits genutzte Wasserkraftpotential identifiziert. Es werden dafür 

praxistaugliche GIS-gestützte Analysen verwendet. 

Gemäss BFE (Piot Michel Oktober 2006) definiert sich das theoretische Potential 

einer erneuerbaren Energie, als das theoretisch physikalisch nutzbare 

Energieangebot innerhalb einer gegebenen Region und innerhalb eines bestimmten 

Zeitraumes. Da es sich bei erneuerbaren Energien meist um jährlich stark 

fluktuierende Grössen handelt, bezieht sich das theoretische Potenzial im 

Allgemeinen auf ein langjähriges Mittel des Energieangebots. 

Teilprojektes B 

Ziel des Teilprojektes B ist eine ganzheitliche Beurteilung des Wasserkraftpotentials 

für Wasserkraftwerke mit einer Leistung <10 MW. Der Fokus liegt auf der Ebene 

einzelner Einzugsgebiete. Das Projekt berücksichtigt und bewertet bei der 

Ausweisung des Wasserkraftpotentials insbesondere sozio-kulturelle, ökonomische 

und ökologische Einflussfaktoren (Systemleistung). Dabei dient das Drei-

Dimensionen-Konzept der nachhaltigen Entwicklung als zentrale Grundlage ((United 

Nations 11.12.1987), (United Nations 2001), (Schweizerischer Bundesrat April 2008), 

(Roth et al. 2007), (Interdepartementaler Ausschuss Nachhaltige Entwicklung 

(IDANE) Mai 2007)). Wichtig ist, dass die Resultate schliesslich regionale wie auch 

nationale Kontexte mit einbeziehen. Bei der Umsetzung ist zudem unbedingt auf eine 

enge Zusammenarbeit mit den verschiedenen Interessenvertretern zu achten. 

 

Folgende Ergebnisse sollten aus dem Projekt hervorgehen: 

Methodik zur ganzheitlichen Beurteilung des Kleinwasserkraftpotentials 

Um schliesslich eine differenzierte Empfehlung zur Nutzung eines bestimmten Raumes 

machen zu können, werden vier Betrachtungsebenen von unterschiedlichem Massstab 

gewählt: Region, Landschaftsteilraum, Gewässerraum und Gewässerabschnitt (Abbildung 3, 

A-D). Zuerst werden der Landschaftsteilraum wie auch der Gewässerraum bewertet und 

zusammengeführt. Daraus resultiert die Systemleistung eines einzelnen Raumes, d.h. eine 
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umfassende, dreidimensionale Beurteilung des IST-Zustandes, aus der sich entweder 

Schutz- oder Nutzungsprioritäten für den betrachteten Gewässerraum ableiten lassen. Eine 

Skalierung und Gewichtung der Werte erlaubt anschliessend den Vergleich mit dem 

hydroelektrischen Potential. Diese Gegenüberstellung erleichtert die Zuordnung von 

Nutzungsprioritäten zu einzelnen Gewässerräumen aus Sicht der Kleinwasserkraft. Es wird 

erwartet, dass eine sehr heterogene Verteilung der drei Nutzungsprioritäten im Raum 

resultieren wird. Daher wird unter Einbezug raumplanerischer Aspekte eine Aggregierung 

vorgenommen, so dass letztlich grossräumige Nutzungs-Empfehlungen abgegeben werden 

können. Durch Austesten der vorgeschlagenen Methodik in den Landschaftsteilräumen und 

Gewässerräumen zweier unterschiedlicher Testregionen, d.h. in den alpinen Lütschine-

Tälern und im voralpinen bis mittelländischen Einzugsgebiet der Emme, soll sie angepasst, 

präzisiert und praxistauglich gemacht werden. 

Szenarienspezifische Karten des ganzheitlichen Kleinwasserkraftpotentials 

für die Pilotregionen 

Je nach gewählter Kraftwerksleistung (10MW, 500kW, 300kW, …) und beabsichtigter, 

zukünftiger Nutzungsintensität bezüglich KWK-Potentialen wird sich ein differenziertes 

Szenario ergeben. Die Lenkung der Szenarien und der definitive Entscheid liegen somit nach 

wie vor bei den Gemeinden, Kantonen und zuständigen Behörden. Die Karten sind als 

Entscheidungshilfe zu verstehen und nicht als Vorgabe. Die potentiellen Gewässerabschnitte 

für KWKW sind Vorschläge. 

Teilprojekt C 

Leitbild zur ganzheitlichen Bestimmung von potentiellen Standorten von 

Kleinwasserkraftwerken des Netzwerks Wasser im Berggebiet. Das Leitbild soll aus 

den Ergebnissen des Projekts A und B erarbeitet werden und in geeigneter Form 

Interessenten zur Verfügung gestellt werden. 

1.2 Begriffs-Definitionen 

Die Erfahrung hat gezeigt, wie wichtig eine klare Definition der verwendeten Begriffe 

zu Beginn der Arbeit ist. Folglich sei hier kurz geschildert wie die Begriffe IST-

Zustand, Potential, Wasserkraftpotential, Systemleistung und Ganzheitlichkeit im 

vorliegenden Projekt verwendet werden. 

 

IST-Zustand versus Potential 

Unter Zustand wird die Beschaffenheit, die Situation oder der Status bzw. die 

Verfassung eines Subjekts oder Objekts verstanden. Im vorliegenden Projekt wird 

der Zustand einer Landschaft oder eines Gewässerraumes über deren aktuellen 
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Charakter und die Ausprägung ihrer Merkmale beschrieben.  Damit bezieht sich der 

Zustand auf etwas, das gegenwärtig existiert, während das Potential vielmehr eine 

Differenz zwischen Subjekten oder Objekten beschreibt. 

 
Abbildung 2 Das Aufwertungspotenzial beschreibt die Differenz zwischen Ist- und Soll-Zustand 
(Beispiel: Ökologie) 
 

Zur Illustration soll das ‚ökologische Aufwertungspotential’ eines Gewässers dienen 

(Abbildung 2). Es definiert sich über die Differenz zwischen dem aktuellen 

ökologischen Zustand des Gewässers und dessen, unter Einbezug gegebener 

Restriktionen (z.B. Hochwasserschutzmassnahmen, Gebäude, Brücken, etc.), im 

best-möglichen Fall zu erreichenden Zustand. Der ursprüngliche natürliche Zustand 

entspricht dem maximalen ökologischen Wert, den ein Gewässer überhaupt je haben 

könnte. Dieser ist allerdings heute vielfach nicht mehr realistisch erreichbar. 

Ein weiteres Beispiel stellt die Definition des ‚guten ökologischen Zustandes’ und des 

‚guten ökologischen Potentials’ gemäss (EU 2000) dar: Ersterer wird vom 

potentiellen natürlichen Referenzzustand abgeleitet, woraus sich ein höheres 

Schutzziel ergibt. Hingegen zieht das ‚gute ökologische Potential’ ein bereits 

verändertes Gewässer als Referenz heran. 

 

Kleinwasserkraftpotential 

Es wird zwischen dem theoretisch nutzbaren und dem bereits genutzten 

Wasserkraftpotential unterschieden. Gemäss BFE (Piot Michel Oktober 2006) 

definiert sich das theoretische Potential einer erneuerbaren Energie, als das 

theoretisch physikalisch nutzbare Energieangebot innerhalb einer gegebenen Region 

und innerhalb eines bestimmten Zeitraumes. Da es sich bei erneuerbaren Energien 
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meist um jährlich stark fluktuierende Grössen handelt, bezieht sich das theoretische 

Potenzial im Allgemeinen auf ein langjähriges Mittel des Energieangebots. Das 

genutzte Wasserkraftpotential entspricht dem Anteil des theoretischen Potentials, der 

unter Berücksichtigung der technischen Restriktionen heute bereits einer Nutzung 

unterliegt. 

 

Systemleistung 

Die Systemleistung entspricht weitestgehend dem Begriff ‚ecosystem services’ wie er 

im Millennium Ecosystem Assessment (Millennium Ecosystem Assessment 2005) 

definiert wurde. Somit beschreibt er sowohl die Unterstützungsfunktion eines 

Ökosystems (Nährstoffkreislauf, Bodenbildung, Primärproduktion) als auch die 

Produktionsfunktion (Nahrungsmittel, Holz und Faser, Brennstoff, Trinkwasser, 

Wasserkraft etc.), die Regulierungsfunktion (Klima, Wasserreinigung, etc.) und die 

kulturelle Funktion (Ästhetik, Erholung, Pädagogik, etc.). Diese Funktionen sollen im 

vorliegenden Fall mittels Indikatoren, welche in Kategorien und ganzen 

Kriterienkatalogen zusammengestellt sind, erfasst werden. Dabei werden analog zu 

den drei Dimensionen der nachhaltigen Entwicklung (Roth et al. 2007) jeweils drei 

verschiedene Perspektiven gewählt; d.h. das System Landschaft bzw. 

Gewässerraum wird aus Sicht der Umwelt, der Gesellschaft und der Wirtschaft 

betrachtet und bewertet. Wir gehen davon aus, dass es uns auf diese Weise gelingt, 

die Systemleistung insgesamt bestmöglich zu erfassen. 

 

Um der Forderung des BfE, im Projekt die von ihnen definierten Begrifflichkeiten zu 

verwenden, gerecht zu werden, seien an dieser Stelle ebenfalls die Definitionen 

gemäss (Piot Michel Oktober 2006) integriert. Demnach kann die Systemleistung 

ebenso als eine Zusammensetzung aus dem ökologischen Potential sowie dem 

sozialen Akzeptanz-Potential verstanden werden. Dabei fliessen auch Elemente des 

erweiterten wirtschaftlichen Potentials ein. (Piot Michel Oktober 2006) definiert das 

ökologische Potenzial als Teil des technischen Potenzials (vgl. Teilprojekt A). Es 

umfasst Gebiete, in denen es zu keiner zusätzlichen irreversiblen Beeinträchtigung 

des Lebensraumes kommen soll. Das heisst Diversität und Wechselwirkungen 

sowohl zwischen den Lebewesen als auch zwischen Lebewesen und ihrer Umwelt 

bleiben erhalten. Als Referenzzustand wird dabei der heutige Zustand betrachtet, 

wobei gesetzliche Anforderungen des Umweltschutzes ebenso mitbestimmend sein 
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sollten (Piot Michel in Vorb.). Mittels sozialem Akzeptanz-Potential fliessen zudem 

Aspekte der Landschaftsästhetik in den Begriff der Systemleistung ein. 

 

1.3 Konzept der Dissertation 

Folgende fünf Arbeitsschritte sollen zum Gesamtziel des Teilprojekts B führen:  

1) Raumgliederung 

 

 

Ausgangspunkt der 

Untersuchungen im 

Teilprojekt B bilden 

Planungsregionen (z.B. 

Berner Oberland) mit 

einer Fläche von 

einigen 100 bis wenigen 

1000 km2 Fläche; diese Regionen werden in einem ersten Schritt in möglichst 

homogene Landschaftsteilräume (Abbildung 3) unterteilt, wobei naturräumliche 

Einheiten wie die hydrologischen Einzugsgebiete oder administrative Grenzen als 

Gliederungskriterien zum Tragen kommen (BAFU et al. 1992, Generalisierte 

Politische Grenzen des Kantons Bern, AGI 2009). Der Landschaftsteilraum definiert 

sich als eine mehrere Quadratkilometer grosse Raumeinheit, die sowohl die 

Gemeindecharakteristik als auch ästhetische Landschaftswerte repräsentiert. Parallel 

dazu erfolgt entlang des Gewässernetzes eine Abgrenzung in Gewässerräume. 

Diese Raumeinheit beschränkt sich jeweils auf wenige 100m. Sie charakterisiert das 

Gerinne wie auch die angrenzende Uferlandschaft. Die Begrenzung soll sich 

einerseits an der Schlüsselkurve zur Sicherung der Biodiversität des Bundes 

(Michael Schilling November 2007) orientieren, aber andererseits auch die 

ökomorphologischen Kartierungen (Gewässer- und Bodenschutzlabor Januar 2008) 

berücksichtigen. 
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Abbildung 3 Überblick Vorgehen Teilprojekt B 
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Sowohl die Erarbeitung und Anwendung geeigneter Abgrenzungskriterien als auch 

die Bewertung des IST-Zustandes ist Aufgabe zweier Studenten. Sie werden sich 

während rund einem Jahr ausführlich damit auseinandersetzen. Als Ergebnis werden 

ein Bericht in Form einer Masterarbeit (MA) sowie Kartendaten zur Bewertung der 

Raumeinheiten erwartet. Die einzelnen Aufgabenstellungen könnten 

folgendermassen aussehen: 

 

MA I 

Abgrenzung von Landschaftsteilräumen LTR (Abbildung 3, Ebene B) 

Hierbei könnten bspw. verschiedene Kriterien für geeignete KWK-Standorte (z.B. aus 

Pelikan 2004 oder Penche 1998) berücksichtigt werden. Womöglich würden dadurch 

allerdings gewisse Landschaftsteilräume von Anfang an ausgeschlossen. Hinsichtlich einer 

gesamtheitlichen Beurteilung ist dies wenig erstrebenwert. Die Abgrenzungskriterien sollten 

entsprechend breit gewählt werden. Ebenfalls sind unbedingt bereits vorhandene 

Grundlagen wie bspw. Information der WaterGisWeb zu verwenden. 

 

Bewertung von Landschaftsteilräumen LTR (Abbildung 3, Ebene B) 

Die Landschaftsteilräume sollen per se nach verschiedenen Kriterien bewertet werden. Die 

Bewertung bezieht sich dabei auf die aktuelle Situation, d.h. sie erfasst den IST-Zustand. Bei 

der Wahl der Kriterien sollte unbedingt vom Drei-Dimensionen-Konzept der nachhaltigen 

Entwicklung (Roth et al. 2007) ausgegangen werden; erst dies erlaubt die korrekte 

ganzheitliche Beurteilung. Daraus ergibt sich für jeden LTR ein gebietsspezifischer Wert, der 

im Folgenden LTR-Wert genannt wird. Dieser Wert setzt sich jeweils aus drei Komponenten 

zusammen, nämlich aus einem ökologischen, einem gesellschaftlichen und einem 

wirtschaftlichen Wert (LTRU,G,W ). 

 

MA II 

Abgrenzung von Gewässerräumen GR (Abbildung 3, Ebene C) 

Für diesen Teilbereich liessen sich Abgrenzungskriterien wie sie bspw. in den 

Massnahmenplänen (z.B. „Oberflächenwasserkörper“, Art. 2, Richtlinie 2000/60/EG) der 

Wasserrahmenrichtlinien der EU (EU 2000) festgelegt sind, verwenden. Ein weiteres 

Instrument stellt das Modul-Stufen-Konzept zur ökomorphologischen Beurteilung von 

Fliessgewässern dar (Hütte, Niederhauser 1998) oder die im Projekt Kander2050 

angewandte Methodik zur Ausscheidung von Gewässerräumen in Bezug auf die 

Flussmorphologie (Michael Schilling November 2007). 
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Bewertung von Gewässerräumen GR (Abbildung 3, Ebene C) 

Aufgrund von ausgewählten Kriterien soll der Gewässerraum lokal – also per se, ohne 

Berücksichtigung der Umgebung – bewertet werden. Es wird auch hier der status quo 

bewertet, d.h. der IST-Zustand. Ebenfalls richten sich die Kriterien nach den drei 

Dimensionen der nachhaltigen Entwicklung, um letzlich dem Anspruch nach einer 

ganzheitlichen Bewertung gerecht zu werden. Als Resultat wir ein spezifischer Wert erwartet, 

der im Folgenden als GR-Wert bezeichnet wird. Ebenso ist auch der GR-Wert dreiteilig, d.h. 

er repräsentiert sowohl den aktuellen ökologischen, gesellschaftlichen als auch 

wirtschaftlichen Zustand eines Gewässers (GRU,G,W ). 

2) Berechnung der Systemleistung aus den Ergebnissen von 1 
(LTRU,G,W und GRU,G,W) 

 

Die Herausforderung des Teilprojekts B liegt darin die 

Systemleistung möglichst ganzheitlich zu bestimmen. Sie 

gibt Auskunft über den Gesamtwert eines 

Gewässerraumes, d.h. aus Sicht der Umwelt, der 

Gesellschaft und der Wirtschaft. Zudem weist sie auf 

vorherrschende Schwerpunkte hin, woraus sich Schutz- und Nutzungsprioritäten 

ableiten lassen. Folgendes Vorgehen versucht diese Ganzheitlichkeit zu erfassen: 

 

In einem ersten Schritt wurde der Blick ausschliesslich auf den gewählten 

Landschaftsteilraum LTR und den Gewässerraum GR gerichtet, ohne 

Berücksichtigung der jeweiligen Umgebung (vgl. Schritt 1). Diese erhalten mithilfe 

von Kriterien (z.B. für LTR: Kulturlandschaftstyp, touristische Nutzung, 

landschaftliche Schönheit, Einmaligkeit, bestehende Eingriffe, Schutzgebiete, etc.; 

für GR: Ökomorphologie, Durchgängigkeit, Biodiversität, etc.) je eine dreiteilige 

Bewertung zwischen 1 bis 5 (LTRU,G,W und GRU,G,W; Formel 1). Diese einheitliche 

Skalierung macht es schliesslich möglich die Ergebnisse verschiedener 

Betrachtungsebenen mit unterschiedlichem Detaillierungsgrad zu vereinen. 

 

{ }

{ }

{ }














=

=

=

=

5,...1

5,...1

5,...1

,,

LTR

LTR

LTR

WGU

W

G

U

LTR   

{ }

{ }

{ }














=

=

=

=

5,...1

5,...1

5,...1

,,

GR

GR

GR

WGU

W

G

U

GR    Formel 1 

 



Disposition  10.04.2010  
Carol Hemund  1 Zielsetzung  

 11/38 

In einem nächsten Schritt wird nun der Blickwinkel etwas geöffnet. Es wird vor allem 

auf den Bezug der beiden Raumeinheiten zueinander geachtet. Dies gelingt mithilfe 

von konstanten Gewichtungsfaktoren, d.h. sowohl jede Raumeinheit als auch deren 

Dimensionen werden separat mit einem gegebenen Faktor multipliziert (Formel 2). 

Dieser Faktor entspricht der Wichtigkeit der jeweiligen Dimension für den LTR oder 

den GR im Vergleich zur anderen Raumeinheit. 
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Anschliessend werden die Ergebnisse für die LTRe und die darin enthaltenen GRe 

aufsummiert. Daraus resultiert die dreiteilige Systemleistung (U, G, W)  pro GR 

(Formel 3).  

 

















+

















=+=

2,0*

4,0*

7,0*

8,0*

6,0*

3,0*

**
,,,,,,,,

GR

GR

GR

LTR

LTR

LTR

WGUWGUWGUWGU

W

G

U

W

G

U

bGRaLTRtungSystemleis Formel 3 

 

 

Diese lässt sich am besten mithilfe eines gleichseitigen Dreiecks darstellen, auf 

dessen Seitenlinien der prozentuale Anteil einer einzelnen Dimension am 

Gesamttotal des GRs aufgetragen wird (vgl. Abbildung 4). Folglich entspricht die 

Seitenlänge 100%; d.h. der Summe der Werte U, G und W eines GRs. Somit kann 

das Ergebnis für jeden einzelnen GR durch einen Punkt innerhalb des Drei-

Dimensionen-Dreiecks dargestellt werden. Je näher der Punkt in einer Ecke liegt, 

desto stärker ist die Dimension Umwelt, Gesellschaft oder Wirtschaft zurzeit in 

diesem Gewässerraum ausgeprägt. Diese Darstellungsweise ermöglicht somit 

Schwerpunkte zu erkennen, welche ausschlaggebend sein sollen für die weitere 

Nutzung des GR. 

 

Ob sich ein GR in Zukunft für eine wirtschaftliche Nutzung eignet oder geschützt 

werden sollte, wird mittels noch festzulegender Grenzwerte (z.B. U: 60%, G: 50%, W: 

40%) entschieden. Folglich wird jedem GR ein Status zugeordnet, der entweder dem 
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Schutz, der Interessensabwägung oder der allgemeinen wirtschaftlichen Nutzung 

Priorität einräumt (3-stufige Skala). 

 

 
Abbildung 4 Systemleistung eines einzelnen Gewässerraumes. Aktuelle Anteile der Dimensionen: 
80% Umwelt, 20% Gesellschaft, 30% Wirtschaft. 
 

Analog zur Herleitung der Systemleistung, lässt sich ebenso für jeden 

Gewässerraum das hydro-elektrische Wasserkraftpotential bestimmen. Diese 

Aufgabe wird durch die WaterGisWeb AG übernommen, d.h. hier entsteht die 

Schnittstelle zwischen Teilprojekt A und B. Die Ergebnisse aus der Potentialstudie A 

werden jedem Gewässerraum aufgeprägt. 

 

Sobald die oben beschriebenen Schritte erfolgt sind und für jeden GR der prioritäre 

Status bzw. das hydro-elektrische KWK-Potential feststeht, folgt die die 

Gegenüberstellung.   

Berechnung -elektrisches KWK-Potential (Bewertung: 3-stufige Skala) 

3) Analyse des hydro-elektrischen KWK-Potentials in den 
ausgewählten Nutzungsräumen und Rangierung der GR 
(Nutzungseignung) 

 

Bereits zu Beginn der Arbeit war sofort klar, wo das grösste Problem bei einer 

ganzheitlichen Beurteilung des Wasserkraftpotentials liegen würde: Die betrachteten 

Einheiten, also die Wasserkraft und der gewässernahe Landschaftsraum, sind nicht 

Umwelt 

Gesellschaft 

Wirtschaft 

100% 

100% 
100% 

U = 80% 

W = 30% 

G = 20% 
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direkt vergleichbar. Während sich das hydro-elektrische 

Wasserkraftpotential quantifizieren lässt (Dimensionen kWh 

bzw. CHF), ist eine solche - letztlich monetäre - Quantifizierung 

bei der Systemleistung nicht oder bestenfalls nur bedingt 

möglich. Deshalb wurde ein 3-stufiges Bewertungssystem 

gewählt, das es ermöglicht, diese unterschiedlichen Einheiten 

direkt zu vergleichen. Verschiedene Studien werden hier zu Rate gezogen und 

schaffen eine geeignete Basis: (Constanza R., Cumberland J., Daly H., Goodland et 

al. 2001), (EU 2000)). 

Sobald die oben beschriebenen Schritte erfolgt sind (Schritt 1 - 2) und für jeden GR 

der prioritäre Status bzw. das hydro-elektrische KWK-Potential feststeht, folgt die die 

Gegenüberstellung, d.h. es wird geklärt inwiefern sich ein GR zur KWK-Nutzung 

eignet. Analysiert werden in erster Linie jene GRe, welche infolge ihrer spezifischen 

Systemleistung den Status ‚Nutzung möglich’ erhielten. Verfügen eben diese GRe 

zusätzlich auch über ein hohes KWK-Potential, so wird eine Nutzung empfohlen. Der 

GR wird in der Graphik grün hinterlegt. Während bei GRen mit hohem Schutzstatus 

und zugleich hohem KWK-Potential von einer zukünftigen KWK-Nutzung abgeraten 

wird. Diese erhalten eine rote Markierung. Orange GRe deuten mögliche 

Kompromisse an, d.h. Interessensabwägungen sind nötig. Die Farbgebung orientiert 

sich am Ampel-Prinzip (3-stufige Skala) und erfolgt stets aus Sicht der 

Kleinwasserkraftnutzung. Als Endergebnis aus Schritt 3 liegt das realisierbare KWK-

Potential pro GR in Form eines drei-stufigen Wertes zwischen 1 und 3 vor (bzw. Rot-

Orange-Grün). 

4) Aggregierung der GR zu grösseren Einheiten (Raumplanung) und 
Bildung von Nutzungsszenarien (variierbare Nutzungsintensität)  

 

Die Arbeitsschritte 1 bis 3 beziehen sich hauptsächlich auf die Ebene B (LTR) und C 

(GR) (vgl. Abbildung 3). Mit dem Einbezug der regionalen Dimension und damit von 

raumplanerischen Aspekten sollen die unter Schritt 3 ermittelten realisierbaren KWK-

Potentiale in ihrem regionalen Kontext (Ebene A) analysiert werden. Ziel ist es 

mithilfe einer Aggregierung der heterogenen räumlichen Verteilung der GRe 

entgegenzuwirken, d.h. die mosaikartig angeordneten GRe werden zu grösseren 

Einheiten zusammengefasst. Dazu erfolgt vorerst eine Rangierung der GRe, welche 

die Höhe der ausgewiesenen Nutzungseignung berücksichtig und somit wiederum 

eine Prioritätensetzung ermöglicht.  Aufgrund der Ränge, der räumlichen Lage und 
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der, von den zuständigen Behörden wählbaren, zukünftigen Nutzungsintensität 

werden die GRe schliesslich aggregiert. 

 

 

 

Die Arbeitsschritte 1 bis 3 beziehen sich hauptsächlich auf die Ebene B (LTR) und C 

(GR) (vgl. Abbildung 3). Mit dem Einbezug der regionalen Dimension und damit von 

raumplanerischen Aspekten sollen die unter Schritt 3 ermittelten realisierbaren KWK-

Potentiale in ihrem regionalen Kontext (Ebene A) analysiert werden. Ziel ist es 

mithilfe einer Aggregierung der heterogenen räumlichen Verteilung der GRe 

entgegenzuwirken, d.h. die mosaikartig angeordneten GRe werden zu grösseren 

Einheiten zusammengefasst. Dazu erfolgt vorerst eine Rangierung der GRe, welche 

die Höhe der ausgewiesenen Nutzungseignung berücksichtig und somit wiederum 

eine Prioritätensetzung ermöglicht.  Aufgrund der Ränge, der räumlichen Lage und 

der, von den zuständigen Behörden wählbaren, zukünftigen Nutzungsintensität 

werden die GRe schliesslich aggregiert. Die Ergebnisse können in Form von 

verschiedenen Szenarien für einzelne Planungsregionen dargestellt werden. Sie 

repräsentieren letztlich das ganzheitlich beurteilte Kleinwasserkraftpotential und 

zeigen, welchen Stellenwert die Wasserkraftnutzung heute und in Zukunft in der 

betreffenden Planungsregion hat bzw. haben soll. Beispielsweise könnte ein 

Szenarium die absolute Bevorzugung der Wasserkraftnutzung (Ausschöpfung 80-

100% des Gesamtpotentials [Σ kWh]) vorsehen, während bei einem andern die 

ökologischen Aspekte oberste Priorität erhalten (50% des Gesamtpotentials). 

Ausgehend von diesen Szenarien lassen sich dann - auf der Grundlage der 

vorgenommenen Bewertungen - für einzelne Regionen Nutzungsprioritäten mitsamt 

deren raumplanerischer Umsetzung ableiten. 
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5) Überprüfung von Einzelprojekten (Wirtschaftlichkeit/UVP) 

 

Im Anschluss an die soeben erläuterten Arbeitsschritte, wären bspw. Studien, die 

sich mit der Prüfung einzelner KWK-Projekte bzw. -Gesuchen hinsichtlich ihrer 

Realisierbarkeit, Wirtschaftlichkeit oder Umweltverträglichkeit (UVP) 

auseinandersetzen, besonders sinnvoll. Aufgrund der oben ausgewählten optimalen 

GRen, liesse sich die Analysearbeit auf ein Minimum reduzieren, d.h. es könnten 

bereits zu Beginn gewisse Einzelprojekte ausgeschlossen werden. 
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2 Problemstellung 

2.1 Analyse des Problemfeldes 

Die Schweizer Energieforschung verfolgt unter anderem das Ziel, die Grundlagen für 

die verstärkte Erschliessung und Nutzung einheimischer, erneuerbarer 

Energiequellen zu schaffen. Dazu gehört auch die Wasserkraft, welche heute ca. 

60% des inländischen Strombedarfs deckt. Die meisten potentiellen Standorte für 

grosse Anlagen werden heute bereits genutzt; noch vorhandene 

Erweiterungsmöglichkeiten sind bekannt. Bei Standorten für kleine 

Wasserkraftanlagen mit einer Leistung von einigen zehn kW bis etwa 10 MW ist dies 

hingegen nicht immer der Fall. 

Noch um 1900 waren in der Schweiz rund 7000 kleine Wasserkraftwerke in Betrieb; 

1000 sind übrig geblieben. Eine Vielzahl der stillgelegten Anlagen kann heute, unter 

anderem aus wirtschaftlichen Gründen, nicht mehr genutzt werden. Seit der Anfangs 

2009 in Kraft getretenen kostendeckenden Einspeisevergütung (KEV), erhalten die 

Kleinwasserkraftanlagen allerdings wieder erhöhte Aufmerksamkeit. Falls sie 

bestimmte Anforderungen erfüllen, wird ihre Stromproduktion fortan finanziell 

unterstützt. Somit können Kraftwerke an vielen, heute nicht mehr oder noch nicht 

genutzten Standorten wirtschaftlich betrieben werden. Damit wächst gleichzeitig die 

teils berechtigte Sorge von Ökologen, Natur- und Landschaftsschützern vor einer 

weiteren Verbauung von zurzeit noch weitgehend unbeeinflussten kleinen 

Fliessgewässern. 

Es ist die Aufgabe des Bundesamtes für Energie eine vernünftige Lösung zu finden. 

Seit längerem zählen zu den Schwerpunkten des BFE-Forschungsprogramms 

„Wasserkraft“ (www.bfe.admin.ch/forschungwasserkraft) auch Potenzialstudien für 

Kleinwasserkraftwerke. Bereits früher hat die Watergisweb AG, Bern, im Auftrag der 

sol-E suisse AG eine Methodik zur Analyse potentieller Standorte entwickelt; vom 

Netzwerk Wasser im Berggebiet (NWB) wurde diese mit dem Swiss Mountain Water 

Award 2008 prämiert. Aufgrund dieser Untersuchung gab das BFE Ende 2008 das 

Forschungsprojekt „Potenzialanalyse Kleinwasserkraft“ in Auftrag. Dabei sollen 

neben der Erfassung der technischen Potenziale auch die naturräumlichen, 

ökologischen und sozioökonomischen Rahmenbedingungen untersucht werden 

(Teilprojekt B), um Wege zu einer nachhaltigen Nutzung der 

Kleinwasserkraftpotenziale aufzuzeigen. Es gilt eine Lösung zu finden, welche 
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versucht die unterschiedlichsten Interessen gesamthaft zu berücksichtigen und 

allseits akzeptiert wird. Somit leistet das Teilprojekt B einen Beitrag zur 

Verkleinerung der gegenwärtig vorherrschenden Lücke bei der Erhebung der 

Kleinwasserkraftpotentiale. Der Fokus der Betrachtungen liegt in der Schweiz. Die 

Erarbeitung eines Konzeptes soll dennoch die Möglichkeit einer internationalen 

Anwendbarkeit nicht ausschliessen. Damit ergeben sich möglicherweise gewisse 

Beschränkungen in der Wahl der Grundlagendaten. Die Methodik sollte auf jeden 

Fall auf verfügbaren Ausgangsdaten aufbauen. 

 

Die Wasserkraftnutzung ist auch in den Medien ein hochbrisantes und 

vieldiskutiertes Thema: „…Die Frage ist: Wie viele Kraftwerke zum Beispiel erträgt die 

Lütschine, oder die Kander? Es gibt kein Masterplan oder Ähnliches, wonach die Behörden 

dies entscheiden könnten….“ (Sahra Fogal 08.01.2009) 

„…Leiter der Klimapolitik beim WWF Patrick Hofstetter meint: „Es geht nicht an, dass jedes 

Wasserkraftwerk und jede Windanlage subventioniert wird. Die einzelnen Projekte müssen 

ökologische Mindestanforderungen erfüllen. Das ist beim heutigen System nicht der Fall.“ 

(Gieri Cavelty 03.02.2009) 

 

Sowohl die Öffentlichkeit, die zuständigen Behörden, Natur- und 

Umweltschutzverbände, Unternehmer als auch die Wissenschaften haben grosses 

Interesse an einer ganzheitlichen Lösung innerhalb nützlicher Frist. Damit ist die 

Ausgangssituation des Teilprojekts B gegeben: Ein Spannungsfeld zwischen Nutz- 

und Schutzinteressen und somit zwischen den einzelnen Akteuren, ihren 

verschiedenen Standpunkten und Forderungen. Die wichtigsten Akteure lassen sich 

wie folgt erfassen: 

 

� Naturschutz 

Gemäss ProNatura (Zusammenfassung 29.01.2009) leben in der Schweiz rund die 

Hälfte aller Tier- und Pflanzenarten an Gewässern. Gleichzeitig gehen Experten 

davon aus, dass rund 90% aller Fliessgewässer nicht mehr natürlich sind (Meyer 

2008, S. 3). Eine Zwischenauswertung des BFE zum ökomorphologischen Zustand 

der Schweizer Fliessgewässer (Erhebungen aus 18 Kantonen), zeigt diesbezüglich 

einen Anteil von 48% (von Benedikt Notter 2006). Diese Ergebnisse beziehen sich 

ausschliesslich auf strukturelle (ökomorphologische) Beeinträchtigungen; 

hydrologische Beeinträchtigungen (Schwall-Sunk-Erscheinungen, 
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Restwassermengen) sind darin nicht enthalten. Naturschützer sehen ihre Aufgabe 

deshalb darin das verzweigte Gewässergeflecht vor weiteren Zerstörungen zu 

bewahren. Der Einsatz von Kleinwasserkraftwerken löst Angst vor einer kompletten 

Zerschneidung der Landschaft aus. So sehen sie im Gegensatz zu grossen 

Kraftwerksanlagen die Gefahr, dass bei der Errichtung mehrer kleiner WKW weitaus 

mehr als nur ein einzelnes Gewässer beeinträchtigt wird. Sie fürchten eine 

Ausbreitung der Gewässerbewirtschaftung bis in den letzten Winkel entlegenster 

Alpentäler. Eine Förderung der Kleinwasserkraft sei nur unter Einhaltung ganz 

bestimmter ökologischer Bedingungen (z.B „naturemade star“ Meyer 2008) und 

Erfüllung definierter Forderungen zulässig. Eine klare Regelung, beispielsweise 

mittels Schutz- und Nutzungsplan, soll die Auszahlung einer KEV für Anlagen in 

Gebieten mit hohem ökologischen Potential verhindern.  

 

� Raumplanung 

Die zunehmende Zersiedelung der Landschaft ist in der Schweiz allgegenwärtig. „Die 

Siedlungsfläche in der Schweiz dehnt sich nach wie vor im Tempo von etwa einem 

Quadratmeter pro Sekunde aus, fastausschliesslich auf Kosten des Kulturlandes. Die 

blosse Flächenstatistik ergibt jedoch kein zutreffendes Bild von der Zerschneidung 

und Zerstückelung der Landschaft. Der Verfasser des folgenden Artikels meint, dass 

nicht die Raumplanung, sondern die Behörden, denen der Gesetzesvollzug obliegt, 

versagt haben." (Hans Weiss 09.09.2008). 

Mit Inkrafttreten der geänderten Energieverordnung (EnV) im Zuge der Revision des 

Energiegesetzes (EnG) 2007, gelten seit Januar 2009 neue Bestimmungen über die 

kostendeckende Einspeisevergütung. Somit erhalten neu Technologien für 

Elektrizität aus erneuerbaren Energien wie Wasserkraft (bis 10MW), Photovoltaik, 

Windenergie, Geothermie, Biomasse und Abfälle aus Biomasse (BFE, UVEK 

28.02.2008) kostendeckende Vergütungen. Die Höhe des Tarifes ist von der 

Leistungsklasse abhängig und wird über eine Dauer von 20 bis 25 Jahren festgelegt. 

Die relativ hohe Rendite bewirkt in der Schweiz „Goldgräberstimmung“. Folglich sind 

bei Swissgrid bis heute rund 400 Anmeldegesuche für Kleinwasserkraftwerke 

eingegangen. 

Seitens der Raumplanung sieht man die Gefahr, dass dadurch eine verstärkte 

Zersiedelung stattfinden wird. „Die KEV führt dazu, dass kleine Anlagen gebaut 

werden, die nicht nötig wären“ (Atzmüller R., Zusammenfassung 29.01.2009) Eine 
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Lösung sehen sie in der Konzentration der Landschaftsentwicklung. Das heisst eine 

einheitlich strukturierte, grossräumige Landschaftsplanung verbunden mit der 

Setzung von räumlichen Schwerpunkten. In Bezug auf die Gewässernutzung müsse 

allerdings erst die Frage nach der Messbarkeit diskutiert werden. Die Qualität des 

Wassers als Element der Landschat soll sichtbar und nutzbar gemacht werden 

könne. 

 

� Kantone 

Auf kantonaler und kommunaler Ebene wird die Forderung nach Leitfäden oder 

Richtlinien zur Gewässerbewertung laut. In einzelnen Kantonen wird bereits versucht 

geeignete Kriterien zur Ermittlung schützenswerter Gewässerabschnitte zu 

erarbeiten (z.B. Kanton Uri, Zusammenfassung 29.01.2009). Andernorts bedient man 

sich bestehender Instrumente wie beispielsweise der „naturemade star“-Kriterien 

(Meyer 2008) zur Durchführung ökologischer Bewertungen (z.B. Kanton Aargau, 

Zusammenfassung 29.01.2009). Es stellt sich allgemein die Frage nach dem Wert 

einer Landschaft und wie derselbe verkauft werden soll. Gute Vorzeigebeispiele 

wären an dieser Stelle eine grosse Hilfe. 

Die Kantone sehen sich zusehends durch den massenhaften Andrang von 

Kleinwasserkraftwerksgesuchen mit der Aufgabe konfrontiert, möglichst rasch zu 

urteilen. Swissgrid AG meldet bis heute 365 Anmeldungen schweizweit. Seit Februar 

werden Neuanmeldungen für Stromanlagen aus Wasserkraft, Photovoltaik, 

Windenergie, Geothermie und aus Biomasse auf eine Warteliste gesetzt. Die für das 

Jahr 2009 zur Verfügung stehende Subventionierungssumme für erneuerbare 

Energien von 250 Millionen Franken ist bereits ausgeschöpft. In einigen Kantonen 

hat die grosse Zahl an Gesuchen bereits zu Planungsnotständen, wenn nicht gleich 

Planungsstopps geführt. Die Zeit drängt. Eine gesamtheitliche Planung mit 

Verankerung im kantonalen Richtplan wäre absolut wünschenswert. Gebiete mit 

erhöhten Schutzansprüchen könnten einfacher ausgeschieden und von Gebieten mit 

einem Schwerpunkt auf dem Ausbau getrennt werden. 

 

�  Energiepolitik 

Gemäss aktuellen Prognosen der internationalen Energieagentur (IEA) erhöht sich 

die jährliche Stromnachfrage in Europa bis ins Jahr 2030 um insgesamt ca. 45%. 

Auch für die Schweiz wird eine zunehmende Nachfrage nach Elektrizität 
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prognostiziert. Der Verband schweizerischer Elektrizitätsunternehmen VSE rechnet 

mit einem Nachfragewachstum zwischen 18% und 45% bis ins Jahr 2030. Auch in 

der Schweiz wird eine Lücke zwischen Nachfrage und Produktion erwartet. Nebst der 

steigenden Nachfrage sind auch die auslaufenden Importverträge mit Frankreich und 

der notwendige Ersatz der alternden Kernkraftwerke Gründe dafür (Peder Plaz und 

Dr. Christian Hanser August 2008)). Ein Mangel zeichnet sich vor allem in der 

Spitzenenergie ab. Damit rückt der Ausbau der Wasserkraft in den Vordergrund. 

Hinzu kommen die zunehmende Förderung erneuerbarer Energien - bis 2050 soll der 

erneuerbare Stromanteil von heute 36% auf 80% gesteigert werden (vgl. auch 

IRENA, Jose Etcheverry & Lily Riahi 27.01.2009) - und das Ziel die Vorgaben 

bezüglich CO2-Reduktion zu erreichen (UNCED Rio 1992, Klimakonvention, Agenda 

21, Kyoto-Protokoll 1997); die Wasserkraftnutzung gewinnt an Bedeutung. Zudem 

hat sich der Bund bis ins Jahr 2050 die so genannte „2000-Watt-Gesellschaft“ zum 

energiepolitischen Ziel gesetzt (Armin Braunwalder 21.04.2006)). Die Erschliessung 

weiterer Energiequellen wird notwendig. Eine denkbare Möglichkeit liegt im Ausbau 

der Kleinwasserkraft. Sie hätte grosses Potential den Anforderungen bezüglich 

nachhaltige Entwicklung und Umweltverträglichkeit gerecht zu werden. Ausserdem 

bedürften grosse Kraftwerke momentan sowieso keiner spezifischen Förderung; 

vernünftige Rahmenbedingungen sollten diesbezüglich ausreichen. 

 

� Energiewirtschaft (Kraftwerkbesitzer/Investoren: BKW, Axpo, Swissgrid) 

Unter den Investoren und Kraftwerksbesitzern löste die Einführung der KEV eine 

regelrechte „Goldgräberstimmung“. Die marktpolitische Förderung der 

Kleinwasserkraftanlagen durch die KEV steigert deren Rendite. 

 

� Wissenschaft 

Aufgabe der Wissenschaft ist es in erster Linie ein übergeordnetes Schutz- und 

Nutzungskonzept zu erarbeiten, in welchem Richtlinien oder unter Umständen sogar 

Gesetze im Rahmen einer alpenweiten Raumplanung vorgeschlagen werden. Es 

geht darum Grundlagen für eine positive Landschaftsplanung zur Verfügung zu 

stellen. Aus Gesprächen (Zusammenfassung 29.01.2009) geht hervor, dass unter 

dem Begriff „positiv“ folgendes verstanden wird: Der Schwerpunkt hinsichtlich 

Landschaftsplanung soll beim Naturschutz liegen und nicht bei der 

Kraftwerksplanung. Dazu sind Instrumente notwendig, die es erlauben 
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Fliessgewässer zu charakterisieren und ihren Schutzbedarf zu ermitteln. Zugleich 

sollten damit Prioritäten gesetzt werden können, die zeigen wo dringender 

Handlungsbedarf herrscht. 

2.2 Abgrenzung des Teilprojekts B 

Mittels einer einleitenden Quellenstudie soll umfassend geklärt werden, ob bereits 

inhaltlich ähnliche Projekte bekannt sind, welche das Wasserkraftpotential auf 

regionaler Ebene ganzheitlich betrachten. Insbesondere ist dabei zu analysieren, 

welchen Stellenwert die Wasserrahmenrichtlinien der EU (EU 2000) besitzen. 

Die Ausrichtung des Teilprojekts B ist sehr interdisziplinär; das bedeutet, dass 

möglichst auch auf Erkenntnissen ähnlicher, aber disziplinär ausgerichteter Projekte 

aufgebaut werden muss. Deshalb gilt es aus methodischer Sicht, sich nicht 

abzugrenzen, sondern zu versuchen, wichtige Erfahrungen solcher Projekte 

gewinnbringend für das vorliegende Teilprojekt B zu verwenden. 

2.3 Motivation & Ideologie 

Mich persönlich sprach in erster Linie die hydrologische als aber insbesondere auch 

die ökologische Ausrichtung des Projektes an. Die Interdisziplinarität faszinierte von 

Anfang an. Die Bereiche Hydrologie, Ökologie, Raumplanung und Wirtschaft 

umfassen ein sehr breites Spektrum. Dabei ist es wichtig die verschiedenen 

Standpunkte und Sichtweisen zu verstehen und einander gegenüberzustellen. Erst 

dadurch wird es möglich eine gesamtheitliche Lösung zu finden, welche allseits 

akzeptiert ist. Meines Erachtens ist dies eine grosse Herausforderung. Das Projekt 

sollte keinesfalls eine Reproduktion sein. Die riesige Flut an Informationen macht es 

einem nicht gerade leicht den Überblick bzw. Durchblick zu gewinnen. Gerade 

deswegen war mir die Zusammenarbeit mit Leuten aus der Praxis und Unterstützung 

durch Fachpersonen ein besonderes Anliegen. Das Projekt soll durch wiederholte 

Begutachtung, kritische Rückmeldungen und Diskussionen vorangetrieben werden. 

Es unterliegt damit ständiger Anpassung und Verbesserung. Dies erfordert Flexibilität 

und Kompromissbereitschaft, was ein weiterer interessanter Aspekt der Arbeit 

darstellt. Zudem ist die gesamte Thematik von höchster Aktualität. Die Forderung 

nach Lösungen wird lauter. Mancherorts sind bereits verschiedenste Projekte 

angelaufen, was die Abgrenzung der vorliegenden Arbeit umso schwieriger macht. 

Zudem umfasst das Projekt sowohl theoretische als aber auch praxisbezogene Teile. 
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Es verfügt somit über eine gewisse Brückenfunktion zwischen Wirtschaft und Praxis, 

was meiner Meinung nach in der heutigen Zeit äusserst wichtig ist. 
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3 Stand der Forschung 
Gemäss BFE  (BFE, UVEK 28.02.2008) verfügt die Schweiz am 01. Januar 2008 

über 532 Wasserkraftwerke mit einer maximal möglichen Leistung ≥300 kW. Alle 

Wasserkraftanlagen von mindestens 10 MW wurden zudem in einer Karte 

zusammengestellt (BFE 2008). Anders sieht es beim aktuellen Gesamtbestand der 

Kleinstwasserkraftwerke (<300 kW) aus. Eine Zählung ist mit sehr viel Aufwand 

verbunden. Deshalb stützen sich die Angaben auf extrapolierte Daten verfügbarer 

Drittquellen und grobe Aussagen (EnG vom Hanspeter Leutwiler). Seit der 

umfangreichen Erhebung 1983-1985 des damaligen Bundesamtes für 

Wasserwirtschaft BWW fand kaum ein Zuwachs statt. Es wurden hauptsächlich 

bestehende Anlagen saniert und deren Leistungseffizienz durch Ausbau gesteigert; 

Neubauten waren äusserst selten. Somit ist auch heute mit rund 700 Strom 

produzierenden Kleinwasserkraftwerken zu rechnen, zu denen sich noch ca. hundert 

bis zweihundert nicht Strom produzierende Wasserräder und Kleinstturbinen 

gesellen (www.smallhydro.ch, Stand: 12.07.2006). Dabei ist es vor allem wichtig zu 

sehen zu welcher Erhöhung und qualitativer Erneuerung der elektrischen Leistung 

und Energieproduktion dies geführt hat. Die Investitionen brachten einen Zuwachs 

von über 11'000 kW Leistung mit 59 Millionen kWh Jahresproduktion. Nicht 

mitgezählt sind die vielen kleinen Produktionssteigerungen mit Modernisierungen, 

welche nicht publik gemacht worden sind. 

Weitere potentielle Standorte (neu/saniert) für Kleinwasserkraftwerke zu ermitteln 

liegt zwar im Interesse vieler, variiert allerdings je nach Kanton in Bezug auf die 

Leistungsansprüche. Der Kanton Bern beispielsweise, interessiert sich zurzeit erst ab 

einer Leistung von <30 kW für Kleinwasserkraftwerke (Aussage U. Schröder 

11.12.08). 

 

Potentiale für kleine Wasserkraftanlagen sind – bei allen regionalen Unterschieden – 

in der ganzen Schweiz vorhanden. Früher wurden begrenzte Potentialstudien 

meistens anhand von Abflussmessungen und topografischen Karten durchgeführt. 

Ziel des BFE-Projekts ist nun die Erarbeitung einer flächendeckenden, einheitlichen 

Datengrundlage für alle Fliessgewässer, welche das theoretisch vorhandene sowie 

das unter verschiedenen Betrachtungsweisen nutzbare Energiepotential darstellt. 

Wie erwähnt hat die Watergisweb AG, Bern, im Auftrag der sol-E suisse AG bereits 

eine Methodik zur Analyse potentieller Standorte für Kleinwasserkraftwerke 
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entwickelt. Die Standortbestimmenden Faktoren sind topografische und 

hydrologische Kennwerte basierend auf vorhandenen GIS-Daten. Entsprechend sind 

dies die Fläche (Gewässernetz GWN25) und der oberirdische Abfluss der 

Einzugsgebiete (MQ-CH) sowie das Gefälle (Höhenmodell DHM25) der Gewässer. 

Weitere Geodaten beschreiben die Nutzungs- und Schutzansprüche, die von den 

unterschiedlichsten Interessengruppen an die Ressource Wasser gestellt werden. 

Es folgt die Ermittlung der hydroelektrischen Energiepotenziale aller Fliessgewässer; 

dabei kommt die entsprechende Analysemethode zum Einsatz. Basierend auf den 

Resultaten werden mit Optimierungsalgorithmen jene Gewässerabschnitte 

identifiziert, die relevante hydroelektrische Potenziale aufweisen. Die potentiellen 

Standorte für Kleinwasserkraftwerke unterschiedlicher Leistungsstufen (10 kW bis 

10 MW) können schliesslich im GIS, resp. In GoogleEarth dargestellt werden (inkl. 

Anteile der Einflussfaktoren). 
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4 Theorie 
In einer ersten Phase des Teilprojektes B geht es vor allem darum zu recherchieren 

und zusammenzutragen, was an ähnlichen oder vergleichbaren Projekten bereits 

vorhanden ist. Das vorliegende Projekt sollte möglichst breit abgestützt sein, auf 

schon gewonnenen Erkenntnissen aufbauen und keinesfalls eine Reproduktion sein. 

Es gilt einen Überblick zu gewinnen über mögliche Methoden und Verfahren, Ideen 

und Hinweise zu sammeln und für eine optimale Ausgangslage zu sorgen. Optimal 

im Sinne von geeigneten Grundbausteinen, mit deren Hilfe das Ziel einer 

ganzheitlichen Erhebung des Kleinwasserkraftpotentials erreichbar wird. Im 

Folgenden sei eine erste Auslegeordnung von verschiedenen Methoden und 

Konzepten dargestellt, welche sich als Vorlagen oder Leitlinien anbieten. Im 

Anschluss wird eine Filtrierung unbedingt nötig sein. 

4.1 Raumplanung 

►Landschaftsentwicklungskonzepte LEK (Bolliger et al. 2002) 

Das wichtigste in Kürze: 

- keine rechtliche Verbindlichkeit, d.h. Massnahmen können mit freiwilligen oder verbindlichen 

Instrumenten auf unterschiedlichen Ebenen umgesetzt werden (z.B. Bewirtschaftungsverträge 

mit Landwirten, kantonaler Richtplan, Nutzungsplan, Ausführung von Einzelprojekten) 

- Arbeitshilfe zum Erarbeiten von LEK: Werkzeugkasten LEK, 4 Akteursgruppen 

(Bewirtschafter, Planer, Bevölkerung, Behörden) 

- Organisation LEK: LEK-Kommission, Einbezug diverser Akteure und Fachpersonen 

- Arbeitsschritte: Ziele und aufeinander folgende Phasen klar definieren; Projektmanagement 

(Projektziele, Schwerpunkte; Organisation, Zusammensetzung Trägerschaft; Partizipation; 

Erfolgskontrolle, Qualitätssicherung; Budget) 

 

► Raumkonzept Schweiz  

Das wichtigste in Kürze: 

- Verankerung im Raumordnungsgesetz (Vernehmlassungsfrist April 2009) 

- Bund, Kantone, Städte und Gemeinde erarbeiten gemeinsam ein Raumkonzept, das der 

Umsetzung ihrer Politikbereiche wie auch als Leitfaden für Akteure aus Wirtschaft und 

Gesellschaft dienen soll (Koordination einer wirkungsvollen Raumentwicklungspolitik) 

- Strategien für Raumtypen: Ländliche Räume (Kpt. 4.2.2), Synthesekarte Landschaft 

(Wasserland, Bergland, Gletscherland, Urbane Verdichtungsräume, Gletscherland, 

Hügelland) 

- „Ebenen, die über 10 km2 gross sind und weniger als 20% Siedlungsflächen aufweisen, sind 

in der  Schweiz selten geworden. Zu ihnen muss man Sorge tragen.“ (S. 31) 
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► Landschaftskonzept Schweiz (Bundesamt für Umwelt 1999) 

Das wichtigste in Kürze: 

- vom Bundesrat am 19. Dezember 1997 gutgeheissen 

- Gliederung in drei Teile: Allgemeine Ziele Natur und Landschaft (S. 7), Sachziele und 

Massnahmen in 13 Politikbereichen des Bundes (S. 17) sowie Erläuterungen (S. 46) 

- Für das vorliegende Projekt sind vor allem die Sachziele 1 (Bundesbauten und –anlagen), 2 

(Energie, enthält unter anderem Weisungen zur Leitungsführung), 7 Natur-, Landschafts- und 

Heimatschutz, 8 Raumplanung, 12 Wasserbau und 13 Wasserkraftnutzung von besonderem 

Interesse 

- enthält wichtige Verweise auf Gesetze und verantwortliche Instanzen (Bundesämter) 

 
► Einführung in die ökologische Ökonomik (Constanza R., Cumberland J., Daly 

H., Goodland et al. 2001) 

4.2 Landschaftsschutz 

► Nationales ökologisches Netzwerk REN (BAFU, BUWAL 2003) 

Das wichtigste in Kürze: 

- Vision für einen landesweit vernetzten Lebensraum Schweiz 

- verfügbare Karten MS 1:100'000 und 1:500'000 (z.B. Kanton Thurgau) 

- Kategorien: Wälder, Lebensräume Thermophile Arten, Lebensräume der Feuchtgebiete, 

Lebensräume der extensiven Landwirtschaft, Lebensräume der Gewässer, andere 

Lebensräume 

 

► Wiederherstellung und Ersatz im Natur- und Landschaftsschutz (Bruno Kägi, 

Andreas Stalder, Markus Thommen 2002) 

Das wichtigste in Kürze: 

Bewertungskriterien für den Ausgangs- und Endzustand von (z.B. Biotopbewertungsmethode 

„Mittelland“): 

- Flächen, welche nicht verändert werden: 

Art des Lebensraumes (in Jahren), Umgebungsqualität (relativer Anteil naturnaher Flächen im 

Umkreis 50m), Vernetzungsfunktion (ist zu bewertende Fläche Trittstein oder Korridor?), 

natürl. Dynamik, Naturnähe (Vergleich mit Lebensräumen des gleichen Lebensraumtyps), 

Qualität des Artenspektrums (Vergleich mit anderen Flächen desselben Lebensraumtyps), 

Anspruchsvolle Arten (seltene Arten mit komplexen Lebensraumansprüchen) 

- Ersatzflächen: 

Herstellbarkeit (Dauer in Jahren bis Lebensraum seine Funktionen erfüllen kann), 

Umgebungsqualität (relativer Anteil von naturnahen Flächen im Umkreis von 50m), 

Vernetzungsfunktion, Natürliche Dynamik, Unterhaltsbedarf, regionale Repräsentativität 
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► naturemadeStar (Meyer 2008) und greenhydro-Kriterien (Christine Batrich und 

Bernhard Truffer Juni 2001) 

 

► Fliessgewässeratlas Tirol, Handbuch 2002 (Christian Vacha August 2002) und 

Checkliste für Wasserkraftwerke bis 15 MW (Michor et al. 2006) 

 

► Ökomorphologische Gewässerkartierungen des BAFU 

Das wichtigste in Kürze: 

- Zwischenauswertungen des BAFU (von Benedikt Notter 2006) zum Fortschritt der kantonalen 

ökomorphologischen Erhebungen an Gewässerabschnitten bis 2005 

- Methode: Modul-Stufen-Konzept 

- Erste Ergebnisse: Bis April 2006 haben 24 Kantone rund 30'650 km Gewässer erhoben. 

Daraus ergeben sich für die Gewässerabschnitte der Schweiz folgende Beurteilungen: 51% 

Stufe 1 (blau) natürlich/naturnah, 24% Stufe 2 (grün)wenig beeinträchtigt, ca. 25% 

beeinträchtigt 

- Bsp. Kanton Bern (Gewässer- und Bodenschutzlabor Januar 2008): 

• zwischen 1997 und 2002 wurden im Kanton Bern rund 6'800 km Flüsse und Bäche 

auf ihren Natürlichkeitsgrad und Raumbedarf hin untersucht und kartiert (das 

entspricht mehr als der Hälfte des gesamten Fliessgewässernetzes des Kantons) 

• Methode: siehe (Meyer 2008) 

• folgende Merkmale wurden erhoben: eingedohlte Bachabschnitte, Sohlenbreite, 

Breiten- und Tiefenvariabilität des Wasserkörpers, Breite und Bewuchs des 

Uferbereichs, natürliche Abstürze (z.B. Wasserfall), künstliche Abstürze (Schwellen) 

und Bauwerke (Durchlässe, Wehre, Fischpässe etc.) 

• Einteilung der Merkmale mittels Punktesystem in 5 Natürlichkeitsklassen (blau: 

natürlich/naturnah, grün: wenig beeinträchtigt, gelb: stark beeinträchtigt, rot: 

naturfremd/künstlich, violett: eingedohlt) 

 

► Gewässerschutzgesetz (GSchG) 

 

► Natur- und Heimatschutz Gesetz (NHV vom 1991) 

 

► Wasserrahmenrichtlinien EU (EU 2000) 

Das wichtigste in Kürze: 

- Art. 2: Begriffsbestimmung (z.B. Oberflächenwasserkörper , Teileinzugsgebiet, ökologischer 

Zustand , gutes ökologisches Potential 

- Art. 4: Umweltziele (Oberflächengewässer, Schutzgebiete) 
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- Art. 5: Merkmale der Flussgebietseinheit, Überprüfung der Umweltauswirkungen menschlicher 

Tätigkeiten und wirtschaftliche Analyse der Wassernutzung (Verantwortung der Umsetzung 

liegt bei jedem Mitgliedstaat; möglicherweise liessen sich hieraus einzelne Beispiele als 

Vorlage verwenden) 

- Art. 11: Massnahmenprogramm (jeder Mitgliedstaat ist dafür verantwortlich bis 2009 für jede 

Flussgebietseinheit ein Massnahmenprogramm zu erstellen (Umsetzung: bis 2012, 

Überprüfung: alle 6 Jahre) 

- Anhang II: Oberflächengewässer 

• 1.1 Beschreibung der Typen der Oberflächenwasserkörper (GIS-Karten) 

• 1.2 Ökoregionen (Anhang XI) und Arten von Oberflächenwasserkörper (Bsp. Flüsse: 

System A oder B, Faktoren: physikal. und chem., Höhe, geographische Breite/Länge, 

Geologie, Grösse, Strömungsenergie, durchschnittliche Wassertiefe, Form und 

Gestalt Flussbett, Feststofffracht, Flussabflussklasse, Niederschlag) 

• 1.3 Festlegung der typspezifischen Referenzbedingungen für Arten von 

Oberflächenwasserkörper (hydromorphologische und physikalisch-chemische 

Bedingungen, raumbezogene typspezifische biologische Referenzbedingungen 

(entwickeln eines Bezugsnetzes mit ausreichend Stellen von "sehr gutem Zustand"), 

modellbasiertes typspezifische biologische Referenzbedingungen (Vorhersagemodell, 

Rückberechnungsverfahren)) 

• 1.4 Ermittlung der Belastungen 

• 1.5 Beurteilung der Auswirkungen (Mitgliedstaaten beurteilen wie empfindlich der 

Zustand der Oberflächenwasserkörper auf die Belastungen reagiert) 

- Anhang IV: Schutzgebiete 

- Anhang V: Zustand der Oberflächengewässer 

• 1.1 Qualitätskomponenten (z.B. Flüsse: biologische Komponenten (Flora, Fauna), 

hydromorphologische Komponenten (Wasserhaushalt (Abfluss, Abflussdynamik), 

Durchgängigkeit, morphologische Bedingungen (Tiefe/Breite, Flussbett, Ufer)), chem. 

und physikalisch-chemische Komponenten (Allgemein (Temperaturverhältnisse, 

Sauerstoffhaushalt, Salzgehalt, Versauerungszustand, Nährstoffverhältnisse), 

Spezifische Schadstoffe (Prioritäre Stoffe, Sonstige)) 

• 1.2 Begriffsbestimmungen (z.B. Flüsse: sehr guter/guter/mässiger Zustand der 

biologische Qualitätskomponenten, hydromorphologische Qualitätskomponenten, 

physikalisch-chemische Qualitätskomponenten) 

• 1.4 Einstufung und Darstellung des ökologischen Zustandes (als Mass für die 

Vergleichbarkeit wird ein Quotient verwendet (1 = sehr guter ökolog. Zustand); 5-

stufige Skalen (blau = sehr gut, grün = gut, gelb = mässig, orange = unbefriedigend, 

rot = schlecht) für den ökologischen Zustand und das ökologische Potential (Farben 

jeweils mit grauen Streifen versehen, hellgrau = künstlicher Wasserkörper, 

dunkelgrau = erhebl. veränderter Wasserkörper)), Darstellung in Kartenform; 

Interkalibrierungsnetz (= Netz von Orten, die aus der Bandbreite von vorkommenden 
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Typen von Oberflächenwasserkörpern ausgewählt werden (wird pro Ökoregion 

erstellt)) 

- Anhang VI: Massnahmenprogramme (Auflistung der Massnahmen) 

- Anhang VII: Bewirtschaftungspläne für die Einzugsgebiete (Merkmale der Flussgebietseinheit, 

Kartierung Oberflächengewässer, Bezugs-/Referenzbedingungen für 

Oberflächenwasserkörpertypen, Zusammenfassung signifikanter anthropogener 

Einwirkungen, Kartierung Schutzgebiete, Überwachungsnetze, Liste der Umweltziele, 

Zusammenfassung Massnahmenprogramme, Zusammenfassung für Entnahme oder 

Aufstauung von Wasser, Zusammenfassung der Massnahmen zur Information- und Anhörung 

der Öffentlichkeit, Liste der zuständigen Behörden, Anlaufstellen und Verfahren für die 

Beschaffung der Hintergrunddokumente und –informationen) 

- Anhang XI: Karte der Ökoregionen für Flüsse und Seen (Bsp. Schweiz: 7 westl. Mittelgebirge, 

8 östl. Mittelgebirge, 9 Alpen) 

4.3  Wasserkraftnutzung 

► International Renewable Energy Agency IRENA (Jose Etcheverry & Lily Riahi 

27.01.2009), http://www.irena.org/ (03.02.2009)) 

Das wichtigste in Kürze: 

- neu gegründetes (Jan 2009), internationales Amt für erneuerbare Energie 

- Hauptziel: 

• weltweite Förderung und Etablierung erneuerbarer Energien, 

• Daten und Informationen zur Verfügung stellen bezüglich Potentialabschätzungen für 

erneuerbare Energien/Technologien 

• Methoden/Abschätzverfahren erarbeiten mit Berücksichtigung der ökologischen, 

politischen, sozio-ökonomischen und kulturellen Bedingungen und Bedürfnisse eines 

Standortes 

• verfolgt ähnliches Ziel wie Teilprojekt B, allerdings auf internationaler Ebene 

 

► European Small Hydropower Association ESHA, Brüssel (www.esha.be 

(18.02.2009) 

- Umweltverträglichkeit von Kleinwasserkraftwerken (ESHA) 

- Handbuch zur Planung und Errichtung von Kleinwasserkraftwerken (ESHA) 
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5 Fragestellung 
Aus den Zielsetzungen des Teilprojektes B lassen sich folgende Fragestellungen 

ableiten: 

♦ Auf welche Art lassen sich Landschaftsteilräume, Gewässerräume sowie 

Flussabschnitte sinnvoll abgrenzen? (MA I, MA II) 

♦ Welche Bewertungsmethodik bzw. -kriterien eignen sich am besten zur 

Ermittlung der Systemleistung, also des IST-Zustandes? 

♦ Wie lassen sich die unterschiedlichen Grössen (hydroelektrisches Potential 

bzw. Systemleistung) messen, so dass sie vergleichbar werden? 

♦ Kann die entwickelte Methodik/Entscheidungshilfe zur Erhebung des 

ganzheitlichen Kleinwasserkraftpotentials in der gewählten Pilotregion 

erfolgreich angewandt werden; wird die Methodik dabei in ihrer Funktionalität 

bestätigt oder sind Optimierungen notwendig? 

♦ Welches System verhilft zur gewünschten Hierarchisierung der 

Gewässerräume in Bezug auf die verschiedenen Bewertungen 

(hydroelektrisches Potential, Systemleistung)? 

♦ Ist es möglich im Spannungsfeld zwischen Naturschutz, Raumplanung, 

Kantone, Energiepolitik, Energiewirtschaft und Wissenschaft eine 

gemeinsame Lösung zu finden? 

♦ Entspricht die entwickelte Methodik der Forderung nach internationaler 

Anwendbarkeit? 
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6 Methoden 

6.1 In fünf Schritten zum Kleinwasserkraftpotential 

Das methodische Vorgehen entspricht dem in Kapitel 1.3 skizzierten Ablauf in fünf 

Arbeitsschritten (vgl. Abbildung 3). Das gewählte Vorgehen ist als erster grober 

Entwurf zu sehen; es soll vor allem in der Anfangsphase des Projektes ständig 

angepasst werden können (aktualisiert: April 2010). Welche Methoden schliesslich in 

den einzelnen Arbeitsschritten angewendet werden ist zum jetzigen Zeitpunkt der 

Arbeit noch nicht definiert. Erst nach einer fundierten Recherche und einer genauen 

Prüfung bereits vorhandener Konzepte und Strategien wird eine geeignete Auswahl 

getroffen. Es kann sich dabei um einzelne Methoden handeln oder aber um 

Verschneidungen mehrer bewährter Ansätze. 

6.2 Austausch und Vernetzung 

Wichtig ist, dass es während des gesamten Ausarbeitungsprozesses zu einem 

Ideenaustausch und zur kritischen Betrachtung von Vorschlägen und 

Lösungsansätzen kommt. Erreicht wird dies durch die Abstützung des Teilprojekts B 

auf drei Begleitteams. 

Lenkungsausschuss 

Eine erste Gruppe bildet der Lenkungsausschuss. Er setzt sich aus Mitwirkenden 

des BFE (Moser), des NWB (D. Soldo), der Entec AG (K. Jorde), der WaterGisWeb 

AG (U. Schröder) und des Geographischen Instituts Bern (Prof. Dr. R. Weingartner, 

PhD C. Hemund) zusammen. Einmal jährlich soll ein Informationsaustausch 

stattfinden und die Koordination des gesamten Projektes „Potentialanalyse 

Kleinwasserkraft“ gefördert werden. 

Wissenschaftliche Begleitgruppe 

Das Teilprojekt B hat eine stark angewandte Komponente und steht somit an der 

Schnittstelle zwischen Wissenschaft und Praxis. Um dieser Verbindungsfunktion 

gerecht werden zu können, wird eine wissenschaftliche Begleitgruppe gebildet. Sie 

setzt sich aus Vertreterinnen und Vertretern der Praxis (Raumplanung, 

Energiewirtschaft, Umweltschutz) sowie der Wissenschaft (Umweltökonomie, 

Wassernutzung) zusammen (Abbildung 5, Stand Aug 2009). Sie soll als Plattform für 

Informations-, Erfahrungs- und Wissensaustausch fungieren. Zugleich bietet sie 
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Personen aus den verschiedensten Bereichen die Gelegenheit zu diskutieren und 

gemeinsam Lösungswege zu erarbeiten. 

 
Abbildung 5: Zusammensetzung der wissenschaftlichen Begleitgruppe 

Patronatskomitee 

Eine breite Abstützung in Wirtschaft und Politik ist ebenso wichtig. Der Austausch 

und die Diskussion zwischen Gesetzgebern und Exekutive soll daher unbedingt ein 

Bestandteil des Projektes sein. Daraus folgt eine weitere Gruppe, die sich aus 

Vertretern von Kantonen, Behörden, Verbänden und Unternehmen zusammensetzt. 

Die Koordination übernimmt das Netzwerk Wasser im Berggebiet (NWB). Die Gruppe 

dient der fachlichen Beurteilung und Begleitung des Projekts. Sie soll die 

Projektbeteiligten dabei unterstützen, die im Vertrag genannten Ziele zu erreichen 

indem sie eine gewisse Beratungs-, Überprüfungs- und Beurteilungsfunktion 

einnimmt. Die Kommunikation der Resultate während der gesamten Projektdauer 

wird noch zusätzlich durch ein jährliches Treffen gefördert. Eine mögliche 

Zusammensetzung der fachlichen Begleitgruppe präsentiert sich folgendermassen 

(Stand Feb 2009): Vertreter von Basler & Hofmann, Swisselectric, RKGK, BfE (K. 

Jorde), BAFU, Schweizerischer Wasserwirtschaftsverband (SWV), Pro Natura. 

 

6.3 Pilotregion 

Um die erarbeitete Methodik zu testen und zu verfeinern soll sie in einer ersten 

Testregion angewendet werden. Dazu wurde das Einzugsgebiet der Lütschine im  

Berner Oberland ausgewählt. Das gesamte Berner Oberland weist ein relativ 
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grosses, noch nicht ausgeschöpftes Wasserkraftpotential auf. Aus der 

Zusammensetzung der wissenschaftlichen Begleitgruppe ergibt sich zudem ein 

gewisser Schwerpunkt in Bern. Das Berner Oberland ist ausserdem die "Heimregion" 

des GIUB, wodurch Synergien zu anderen Projekten genutzt werden können. Mit der 

vorgeschlagenen Pilotregion reduziert sich auch der Reiseaufwand für 

Masterstudierende. 

Eine zweite Anwendung ist im voralpinen bis mittelländisch geprägten Einzugsgebiet 

der Emme vorgesehen. Dies einerseits mit der Absicht, die Methode als Ganzes an 

einem weiteren Gebiet zu testen und auf ihre Funktionalität hin zu prüfen. 

Andererseits können auf diese Weise auch notwendige Anpassungsvorschläge für 

ausseralpine Gewässer gemacht werden. Schliesslich soll die Methodik universell 

angewendet werden können, d.h. für beliebige Einzugsgebiete der Schweiz. 
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7 Arbeits- und Zeitplan 
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Traktanden 
 

1. Begrüssung (RW) 
2. Projektübersicht 
3. Rückblick Sitzung III (CH) 
4. Stand der Arbeit (CH) 
5. Ergebnisse (CH) 

a. Ergebnisse Pilotregion 1 (Lütschine) 
b. Erfahrungen bei der Umsetzung in Pilotregion 2 Emme 
c. Folgerungen 

6. Anpassungen Methode (CH) 
7. Zusammenfassung und Konsequenzen für das weitere Vorgehen (CH) 
8. Fragen und Diskussion (alle) 
9. Varia 

  
 
Abkürzungen 

GIUB: Geographisches Institut, Universität Bern 
GR: Gewässerraum 
KWK: Kleinwasserkraft 
LTR: Landschaftsteilraum 

 
1. Begrüssung 

RW begrüsst die Teilnehmer und deutet auf die Wichtigkeit der heutigen Sitzung hin. Die 
Sitzung ist wichtig, weil sich das Projekt an einem Punkt befindet, wo eine Lenkung nötig ist. 
 

2. Projektübersicht 
3. Rückblick Sitzung III (CH) 
4. Stand der Arbeit (CH) 
5. Ergebnisse (CH) 

RW bezieht sich auf die Aussage von CH, wo die Grenze einer neutralen Auslegung zu einer 
eindeutigen Empfehlung liegt. Dabei möchte er von den Teilnehmern wissen, wo für sie die 
Wissenschaft aufhört und Politik beginnt. DK findet den Nutzungsentscheid einen politischen 
Entscheid. Meist wird die Verantwortungsübernahme an die Verwaltungen zurückdelegiert. Die 
Wissenschaft soll also den Verwaltungen die Entscheidungsgrundlage liefern. Die 
Wasserstrategie des Kantons Bern ist eine politisch beeinflusste Entscheidungsgrundlage. GK 
möchte, dass die GR nach ihrer Qualität priorisiert werden mittels 
Reihenfolgen/Prioritätenlisten. Ausserdem sollte sich das Projekt tiefgründig mit den 
Abwägungsräumen auseinandersetzten. RW und DK finden, dass bei den Abwägungsräumen 
die Politik selber entscheiden muss je nachdem welche Wasserkraftausschöpfung sie 
verfolgen. Nach AS ist auch die Gewichtung politisch. RW deutet darauf hin, dass je nach 
Energieziel die durch CH zu entwickelnden Szenarien als Entscheidungsgrundlage dienen 
werden (Transformationswissen). 
 
RH möchte wissen wie viele Strecken zur Nutzung empfohlen werden (go-Strecken). Diese 
Frage kann jedoch noch nicht beantwortet werden. 

a. Ergebnisse Pilotregion 1 (Lütschine) 
b. Erfahrungen bei der Umsetzung in Pilotregion 2 Emme 
c. Folgerungen 
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6. Anpassungen Methode (CH) 
7. Zusammenfassung und Konsequenzen für das weitere Vorgehen 

(CH) 
8. Fragen und Diskussion (alle) 

Verständnisfragen: 
HH möchte wissen weshalb Gebiete mit bestehender Wasserkraftnutzung anders behandelt 
werden sollten. Diese sollen genau gleich wie alle anderen GR beurteilt werden. Es ist daran 
zu denken, dass jede Nutzung mit Konzessionen begrenzt ist. CH bestätigt, dass auch GR mit 
bestehender Nutzung auf alle Kriterien untersucht werden. Mit den Wasserkraftregionen  geht 
es darum, die Bedeutung der Nutzung hervorzuheben. In einer Wasserkraftregion würde ein 
GR eher zur Nutzung freigegeben. 
 
KJ möchte wissen wie die Gemeindetypen und die Wasserkraftregionen die Beurteilung 
beeinflussen. Die Kriterien würden keine zusätzlichen Informationen geben und folglich nichts 
an der Empfehlung ändern. RW betont, dass der GR im Zentrum der Beurteilung steht. Der GR 
ist aber vom Umfeld nie losgelöst. Im Umfeld soll es also keine neue Bewertung ergeben, 
sondern eine Feinjustierung der GR-Klasse. Das Umland führt zur Differenzierung. RH fehlt die 
natürliche Gemeinde unter den neun Gemeindetypen. Auf dieser Ebene werden aber keine 
ökologischen Aspekte mehr untersucht, sondern gesellschaftliche und wirtschaftliche. Die 
Gemeindetypen bilden einen Summenparameter aus den gesellschaftlichen und 
wirtschaftlichen Kriterien von DS. Die ökologischen Kriterien werden nur im GR erhoben. RW 
weist darauf hin, dass die Gemeindeebene immer eine räumliche Unschärfe bedeutet. Sie 
dient als Nachjustierung. TA findet die Beurteilung mittels Gemeindetypen eine sehr gute Idee. 
 
Diskussion: 
AS findet, dass das Theoretische Potential zu wenig aussagt. Dies sollte mit der 
Zugänglichkeit des Gewässerabschnitts sowie mit wirtschaftlichen Aspekten ergänzt werden. 
KJ weist darauf hin, dass dies nicht Bestandteil dieses Projekts ist. Eine solche Berechnung 
wird sehr schwierig sobald nicht nur physikalische Aspekte einfliessen. 
 
TA stellt sich vor, dass viele Strecken nur teilweise genutzt werden könnten. So könnte 
beispielsweise bei Schneeschmelze der zusätzliche Abfluss genutzt werden. Oder eine 
kleinere Nutzung des Tagesabflusses, dafür eine stärkere Nutzung des Abflusses in der Nacht 
falls ein Gewässer beispielswiese aus gesellschaftlichen Gründen (Bsp. Wassersport) 
geschützt werden sollte. Es sollte also auch ein Mittelweg zwischen Schutz und Nutzen 
möglich sein. In Kanada gibt es da bereits gute Erfahrungen. DK findet,  dass man die Politik 
damit inspirieren könnte. Ausserdem sollte es bei grösseren Abflüssen eine grössere Toleranz 
der Nutzung geben.  
 
 
 
Protokoll: 16. November 2010, JH u. CH 
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Datenmodell GIUB 

1 Auszug aus „Beschlussprotokoll Besprechung 
Datenaustausch“ (vom 12.05.2009) 

1 Datenaustausch WGW �������� GIUB 
 
1.3 Datenbasis 
GIUB: 
> flächenbasiert 
> lückenfrei, nicht überlagernd 
 
1.4 Datenaustausch WGW -> GIUB 
WGW liefert die Daten pro Punkt als Tabelle in einer ESRI Personal Geodatabase (PGDB). 
Die Daten können als XY-Event oder als Route-Event dargestellt werden. 
Die Punkte sind über das Attribut PK (Typ: varchar2(50)) eindeutig identifiziert. 
 
1.5 Datenaustausch GIUB -> WGW 
GIUB liefert die Resultate ebenfalls in Form von PGDB an WGW als Punktdaten. Die 
Resultate werden analog zu 1.4 in eigenen Entitäten in das bestehende Datenmodell von 
WGW integriert. Dies erlaubt eine einfache Erweiterung des bestehenden Modells, ohne 
bestehende Entitäten anzupassen. 
Die Struktur der Entitäten muss zu gegebenen Zeitpunkt vom GIUB definiert und an WGW 
weitergegeben werden. 
Als Identifikator für die Verbindung zwischen den Punkt- und Sachdaten wird der oben 
erwähnte Schlüssel (PK vom Typ varchar2(50)) verwendet. 
 
1.6 Daten der GIUB-Pilotregion Lütschinen 
Die vom GIUB gewünschten Daten werden bereitgestellt, sobald diese mit den 
schweizweiten Daten (siehe Kap. 1.1) berechnet wurden. 
 
Tabelle 1 Definition der Information pro Punkt 
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2 Daten vorbereiten 

2.1 Eigener Datenspeicherort erstellen 

Innerhalb des GISproject Ordners : ..:\...\GISproject\GIS…(Name)\...(ev. neuer 
Ordner) 
� z.B. D:\Carol\GISproject\GIScarol\hem 

2.2 MS Excel 

lue_rz.xls (Excel Table) 
1) Tabelle wie folgt erstellen: 
 

NO ECL SOC ECN WFACTOR.LU 

1 0,1,…4 0,1,…4 0,1,…4 0.9 
2 0,1,…4 …  0.5 
3 …   … 
…     
  
� Tipp: Spalte WFACTOR.LU > Punkt statt Komma verwenden 
 
2) Zeile 1 markieren > rechte Maustaste > Zellen formatieren > Tab: Zahlen > Text 
 
3) Alle übrigen Zellen markieren ausser Spalte WFACTOR.LU > rechte Maustaste > 
Zellen formatieren > Tab: Zahlen > Zahl > Dezimalstellen: 0 
 
4) Zellen der Spalte WFACTOR.LU markieren > rechte Maustaste > Zellen 
formatieren > Tab: Zahlen > Zahl > Dezimalstellen: 1 
Datei > Speichern > in vorbereiteten Ordner (..:\...\GISproject\GIS…(Name)\...(ev. neuer 
Ordner)) > Dateiname: lue_rz > Dateityp: Microsoft Office Excel-Arbeitsmappe > 
Speichern 
 
5) Datei > Speichern unter > in vorbereiteten Ordner (..:\...\GISproject\GIS…(Name)\...(ev. 
neuer Ordner)) > Dateiname: lue_rz > Dateityp: DBF 4 (dBase IV) > Speichern 
 
lue_lu.xls (Excel Table) 
1) Tabelle wie folgt erstellen: 
 

NO ECL SOC ECN WFACTOR.RZ 

1 0,1,…4 0,1,…4 0,1,…4 0.9 
2 0,1,…4 …  0.5 
3 …   … 
…     
  
� Tipp: Spalte WFACTOR.RZ > Punkt statt Komma verwenden 
 
2) Zeile 1 markieren > rechte Maustaste > Zellen formatieren > Tab: Zahlen > Text 
 
3) Alle übrigen Zellen markieren ausser Spalte WFACTOR.RZ > rechte Maustaste > 
Zellen formatieren > Tab: Zahlen > Zahl > Dezimalstellen: 0 
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4) Zellen der Spalte WFACTOR.RZ markieren > rechte Maustaste > Zellen 
formatieren > Tab: Zahlen > Zahl > Dezimalstellen: 1 
Datei > Speichern > in vorbereiteten Ordner (..:\...\GISproject\GIS…(Name)\...(ev. neuer 
Ordner)) > Dateiname: lue_lu > Dateityp: Microsoft Office Excel-Arbeitsmappe > 
Speichern 
 
5) Datei > Speichern unter > in vorbereiteten Ordner (..:\...\GISproject\GIS…(Name)\...(ev. 
neuer Ordner)) > Dateiname: lue_lu > Dateityp: DBF 4 (dBase IV) > Speichern 

2.3  

2.4 Arc Catalog 

lue_lu.dbf (dBASE Table) 
lue_lu.dbf > rechte Maustaste > Properties > Tab: Indexes > Häckchen für alle > OK 
 
lue_rz.dbf (dBASE Table) 
lue_rz.dbf > rechte Maustaste > Properties > Tab: Indexes > Häckchen für alle > OK 
 
lue_elPot.shp (Shapefile) 
…:\...\GISproject\GISbasics\WaterGISWeb AG\Daten Potentialstudie BFE Luetschine\LUE.dbf > 
Rechte Maustaste > Create Feature Class > From XY Table… > Input Fields: X 
Field: EASTING > Y Field: NORTHING > Output: Specify output shapefile or feature 
class: > Ordner Icon > Saving Data: lue_elPot.shp (Pfad: 
…:\...\GISproject\GIS…(Name)\...(Ordner)\lue_elPot.shp) > OK 
 
lu.shp (Shapefile) 
Arc Catalog (Arc Map nicht öffnen) > z.B. im neuen Ordner 
(…:\...\GISproject\GIS…(Name)\...(Ordner)) > rechte Maustaste > New > Shapefile > Name: 
lu > Feature Typ: Polygon > Spatial Reference > Edit > XY Coordinate System > 
Select > Projected Coordinate Systems > National Grids > CH1903 LV03.prj > Add > 
OK > lu.shp erscheint im Ordner > rechte Maustaste > Shapefile Properties > Tab: 
Fields 
 

Field Name Data Type Field Properties 

FID Object ID - 
Shape Geometry Geometry Type: Polygon 
NO Double Precision: 18; Scale: 2 
   

  
Übernehmen > Tab: Indexes > Häckchen für alle > OK 
 
rz.shp (Shapefile) 
Arc Catalog (Arc Map nicht öffnen) > z.B. im neuen Ordner 
(…:\...\GISproject\GIS…(Name)\...(Ordner)) > rechte Maustaste > New > Shapefile > Name: 
rz > Feature Typ: Polygon > Spatial Reference > Edit > XY Coordinate System > 
Select > Projected Coordinate Systems > National Grids > CH1903 LV03.prj > Add > 
OK > rz.shp erscheint im Ordner > rechte Maustaste > Shapefile Properties > Tab: 
Fields 
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Field Name Data Type Field Properties 

FID Object ID - 
Shape Geometry Geometry Type: Polygon 
NO Double Precision: 18; Scale: 2 
   

  
Übernehmen > Tab: Indexes > Häckchen für alle > OK 



Datenmodell GIUB (GIS)  hem 11.01.2010 

6/10 

3 Arc Map 

3.1 Standardeinstellungen 

1) View > Data Frame Properties … 
> Tab: General > Units: Display > Meters 
> Tab: Coordinate System > Select a coordinate system > Predefined > Projected 
Coordinate Systems > National Grids > CH1903 LV03 
 
2) File > Document Properties > Summary: data Source Options… > In this map 
document: Store relative path names to data sources > OK > OK 
 
3) Add Data 
PK25 
Pfad 1: ..:\..\GISproject\GISbasics\swisstopo\PK25\GD091015-002-R - 
136399\PK\PK25_03\2005\R1\10L\KREL0001.TIF und KREL0002.TIF und KREL0003.TIF und 
KREL1249.TIF 
Pfad 2: …:\...\GISproject\GISbasics\swisstopo\PK25\GD091015-002-R - 
136399\PK\PK25_03\2006\R1\10L\KREL0004.TIF und KREL0005.TIF und KREL0006.TIF und 
KREL1229.TIF 
 
� Einzelne Kartenblätter lassen sich gruppieren: Alle markieren > rechte Maustaste: 
Group > New Group Layer: z.B. PK25 
 
lue_gwn25 arc (Coverage Feature Class) 
Pfad: …:\...\GISproject\GISbasics\swisstopo\VECTOR25\lue_gwn25 
lue_elPot.shp 
Pfad: …:\...\GISproject\GIS…(Name)\...(Ordner)\lue_elPot.shp 
lue_lu.dbf 
Pfad: …:\...\GISproject\GIS…(Name)\...(Ordner)\lue_lu.dbf 
lue_rz.dbf 
Pfad: …:\...\GISproject\GIS…(Name)\...(Ordner)\lue_rz.dbf 
lu.shp 
Pfad: …:\...\GISproject\GIS…(Name)\...(Ordner)\lu.shp 
rz.shp 
Pfad: …:\...\GISproject\GIS…(Name)\...(Ordner)\rz.shp 

3.2 Polygone zeichnen 

1) Editor (siehe Toolbar) > Start editing > Source: …\...\GISproject\GIS…(Name)\...(Ordner) 
2) Task (Toolbar): Create New Feature 
3) Target (Toolbar) > lu bzw. rz wählen 
4) Editor (Toolbar) > Snapping… > Layer: lu bzw. rz (je nach Wunsch Weitere) 
entsprechendes Häckchen setzten (Vertex) > Edit Sketch: Häckchen setzen 
Sketch Tool > Polygone zeichnen (WICHTIG: lückenfrei, nicht überlagernd!) > Editor 
> Save Edits 
5) lu bzw. rz > rechte Maustaste > Open Attribute Table > Spalte: NO > die einzelnen 
Polygone mit der entsprechenden Nummer versehen > Save Edits > Stop Editing 
 
���� Tipp: Falls zur Identifizierung der einzelnen Polygone diese markiert werden 
(Zeile in Table oder von Hand direkt in der Karte mit Edit Tool (Toolbar) markieren), 
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dann arbeitet Arc Map schneller, wenn dazu die Ebene PK25 „unsichtbar“ gemacht 
wird (Häckchen im Display entfernen) 
 
���� Tipp: Spalte Id im Attribute Table kann entfernt werden: lu bzw. rz > rechte 
Maustaste > Open Attribute Table > Spalte markieren > Options > Delete Field 

3.3 Verknüpfung: Polygone (shp) mit Daten (dbf) 

lu bzw. rz > rechte Maustaste > Joins and Relates > Join Data > What do you…: Join 
attributes from a table > 1. Choose the field …: NO > 2. Choose the table…: lue_lu 
bzw. lue_rz > Show the attribute tables…: Häckchen > 3. Choose the field…: NO > 
OK 
 
� beim Öffnen des Attribute Tables von lu bzw. rz sollten nun alle Werte aus der xls-
Tabelle beim entsprechenden Polygon eingetragen sein (Bitte Überprüfen!) 
 

 
Abbildung 1 Darstellungsbeispiel für die Verknüpfung von lu.shp mit lue_lu.dbf 

3.4 Verschneidung beider räumlichen Betrachtungsebenen (lu.shp 
und rz.shp zu ) 

� Diesen Arbeitsschritt erst durchführen, wenn die Shapefiles lu bzw. rz mit den 
jeweils dazugehörenden dBASE-Tables (lue_lu.dbf resp. lue_lu.dbf) verlinkt sind 
(siehe oben: Join Data) 
 
Arc Toolbox > Analysis Tools > Overlay > Identity > Input Features: rz > Identity 
Features: lu > Output Feature Class > Name: lue_Identity 
(…:\...\GISproject\GIS…(Name)\...(Ordner)\lue_Identity.shp) > Join Attributes > ALL > OK 
 
�beim Öffnen des Attribute Tables von lue_Identity sollten nun für jede Riverine 
Zone (rz_NO) zusätzlich die Werte der entsprechenden Landscape Units ersichtlich 
sein (d.h. FID lu lue, lu NO, lue lu OID, lue lu NO, lue lu ECL, lue lu SOC, lue lu ECN, 
WFACTOR.RZ) 
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Abbildung 2 Ausgangslage der Verschneidung von Landscape Units (links, lu.shp) und Riverine 
Zones (rechts, rz.shp) 
 

 
Abbildung 3 Resultat der Verschneidung beider Datensätze lu.shp und rz.shp: Systemleistung 
jeder einzelnen Riverine Zone (lue_Identity) 

3.5 Verknüpfung GIUB-Daten (lue_Identity) mit WaterGISWebAG-
Daten (lue_elPot) 

lue_Identity > rechte Maustaste > Joins and Relates > Join Data > What do you…: 
Join data from another layer based on spatial location > 1. Choose the layer to join to 
this layer, … > lue_elPot > 2. You are joining: Points to Polygons; Select a join… > 
Markierung bei: Each polygon will be given all the attributes of the point that is… > 3. 
The result of the join will be saved into a new layer. Specify output… > Name: 
lue_Join.shp > Save > …:\...\GISproject\GIS…(Name)\...(Ordner)\lue_Join.shp > OK 
 
�beim Öffnen des Attribute Tables von lue_Join sollten nun für jede riverine zone 
(rz_NO) zusätzlich die Werte der Punktdaten zum hydroelektrischen Potential 
(lue_elPot) ersichtlich sein (d.h. FID 2, OBJECTID, GWLNR, MEASURE LI, 
EASTING, NORTHING, …PK) 
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Abbildung 4 Ergebnis der Verknüpfung der Systemleistungen (lue_Identity.shp) mit den 
Punktdaten des hydroelektrischen Potentials (lue_elPot.shp) 
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4 Definitionen 
Index Datenformat Beschreibung 

elPot - Hydroelektrisches Potential (Datensatz der WaterGIS Web AG) 
lue - Einzugsgebiet, 3 Ziffern (z.B. Luetschine) 
lu - Landscape Unit (Landschaftsteilraum) 
rz - Riverine Zone (Gewässerraum) 
lu.shp Shapefile Enthält 

a) Polygone, d.h. Landscape Units 
b) Verknüpfung mit lue_lu.dbf 

lue.mxd Map 
Document 

Arbeitsblatt in Arc Map; ist individuell gehalten; dient nicht dem 
Datentransfer 

lue_elPot.shp Shapefile Point-Shapefile; enthält alle Daten der WaterGIS Web AG 
(Attribute) für jeden einzelnen Gewässerpunkt 

lue_Identity.shp Shapefile Verknüpfung der Datensätze beider räumlichen Ebenen (lu.shp und 
rz.shp); daraus ersichtlich wird die Systemleistung einer Riverine 
Zone 

lue_Join.shp Shapefile Verknüpfung der Datensätze von der WaterGIS Web AG 
(lue_elPot.shp) und dem GIUB (lue_Identiyty.shp); jedem 
Gewässerpunkt wird seine Zugehörigkeit zur entsprechenden 
Riverine Zone (resp. Landscape Unit) zugeordnet 

lue_lu.xls Excel Table Enthält sämtliche Daten zu den Attributen NO, ECL, ECN, SOC und 
WFACTOR für die Landscape Units 

lue_lu.dbf dBASE 
Table 

Enthält die gleichen Daten wie lue_lu.xls, jedoch im Format DBF 4 
(dBase IV) 

lue_rz.xls Excel Table Enthält sämtliche Daten zu den Attributen NO, ECL, ECN, SOC und 
WFACTOR für die Riverine Zones 

lue_rz.dbf dBASE 
Table 

Enthält die gleichen Daten wie lue_rz.xls, jedoch im Format DBF 4 
(dBase IV) 

rz.shp Shapefile Enthält 
a) Polygone, d.h. Riverine Zones 
b) Verknüpfung mit lue_rz.dbf 

 
 
Attribut Typ Einheit Beschreibung 

PK Text 50 - Eindeutig Identifikation des Gewässerpunktes 
NO Double - Nummer der räumlichen Einheit 
AREA Double sq km Fläche der räumlichen Einheit 
ECL Double {0,1…4} ecological assessment (ökologische Bewertung der 

räumlichen Einheit) 
ECN Double {0,1…4} economical assessment (ökonomische Bewertung der 

räumlichen Einheit) 
SOC Double {0,1…4} social assessment (sozio-kulturelle Bewertung der räumlichen 

Einheit) 
WFACTOR Double {0.1,…0.9} weighting factor (Gewichtungsfaktor für die jeweils andere 

räumliche Einheit) 
 


